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ABOUT THIS GUIDE 

INTEGRATING ONESOURCE INDIRECT TAX WITH SAP 
Corporations using SAP as their Enterprise Resource Planning System can simplify their worldwide 
US sales and use tax, Canadian GST, HST, QST, and PST by implementing ONESOURCE Indirect 
Tax Application Suite of products. The suite includes Determination Moduleand Integration Module 
for SAP. The benefits provided by ONESOURCE Indirect Tax Application Suite are: 

• Fast, accurate sales, use, and consumer’s use tax results and Canadian taxes.
• Complete audit database from which you can generate both standard and custom reports,
as well as returns.

ONESOURCE Indirect Tax Integration Module for SAP makes use of the SAP provided Standard 
Tax Interface and its underlying Remote Function Calls (RFC) and SAP’s Java Connector (JCo) to 
communicate with ONESOURCE Indirect Tax Determination. As of release 5.2.2.0, this integration 
provides support for SAP Secure Network Communication (SNC) to secure your RFC 
connections. ONESOURCE Indirect Tax Integration for SAP is certified by SAP for the United 
States of America and Canada for use with the SAP ERP. 

The standard installation and configuration of ONESOURCE Indirect Tax Integration for SAP 
enables instant integration of SAP business processes with ONESOURCE Indirect Tax 
Determination. Tax details are returned in real time to the calling SAP transaction. Tax 
determination is based on the data elements sent from SAP to ONESOURCE Indirect Tax 
Determination. Additional data elements, often necessary for the accurate determination of 
consumer’s use tax on complex transactions, can be mapped to ONESOURCE Indirect Tax to allow 
for unique customer tax and reporting requirements. 
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HOW THIS GUIDE IS ORGANIZED 
 
 

HOW THIS GUIDE IS ORGANIZED 
This guide leads you through procedures in the following chapters: 

 
• INTEGRATION OVERVIEW shows the benefits of integrating Determinationsoftware 

with SAP and describes both an architectural and configuration overview ofIntegration 
process. 

• CONFIGURE SAP TO ALLOW CALLS TO COMMUNICATE WITH DETERMINATION 
describes the steps you need to take to enable SAP RFCs to call Determinationto perform 
tax calculations and return the tax results back to SAP RFCs. 

• INSTALLING AND CONFIGURING INTEGRATION FOR SAP explains how toinstall 
and initially configure Integration for SAP. 

• DEFINING A COMPANY IN DETERMINATION FOR RFC TESTING provides information on 
Determination configurations that enable the two systems to successfullytransfer and 
process transaction data. 

• ADVANCED CONFIGURATIONS IN INTEGRATION FOR SAP describes how toenable 
custom support of Custom Authority tax result mappings in SAP. 

• ENABLING CUSTOM ATTRIBUTES provides and overview of the tax processand user 
exits, explains how to append the interface, 

• APPENDIX 1: MAPPING lists the input and output maps used to associate SAPdata fields 
to Determination XML elements. 

• APPENDIX 2: TRANSPORTS provides additional needed information. 
 

After you complete the procedures in this guide, follow the instructions in the ONESOURCE 
Indirect Tax Integration for SAP US/CA Tax Configuration Guide. 

 
Once you finish these steps, your SAP implementation can leverage the full set of calculation, 
auditing, and reporting features of Determination for all US and Canada taxes. 
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SKILL AND ACCESS PREREQUISITES 
 
 

SKILL AND ACCESS PREREQUISITES 
This guide is intended for use by ONESOURCE Indirect Tax Professional Services and your SAP 
System Administrator, Configurator, or Superuser. The purpose of this guide is to walk you through 
the step-by-step process of installing and configuring both Integration and SAP so that SAP RFCs 
can communicate with Determination. The examples in this guide are taken from SAP ECC 6.0. 

 
The following table lists the required knowledge, permissions, and other information that will help 
you proceed quickly through the installation and configuration. 

 

Skill and Access Prerequisites 

Requirement Description 
Technical Skills • UNIX or Windows System Administrative 

Privileges 
• Experienced User of UNIX or Windows 
• Using Determination 
• ABAP 

SAP Authorizations • Configurator (IMG) 
• Defining and Testing RFC Destinations 
• System Administrator 
• Ability to run SE37 transactions to execute 

Tax Interface RFCs 

 
 

SITE-SPECIFIC SYSTEM CONFIGURATION 
The scripts and procedures used in this guide reference the following information about your 
implementation which you should determine before running the installation. Refer back and use 
the table below to list these values as you complete the steps outlined throughout this install guide. 
They will become a handy reference. 

 

Information About your SAP Implementation 

Item Description Page Reference 

SAP CPIC Username 
and Password 

Username and password to enable the JCo Client to 
connect to SAP. 

Created on: SAP ECC 
CONFIGURATION 

SAP System Number System number to connect to thehost server. Per your SAP install, used on: 
CONFIGURING 
INTEGRATION 
PROPERTIES FILE 
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SITE-SPECIFIC SYSTEM CONFIGURATION 
 
 

Information About your SAP Implementation 

Item Description Page Reference 

SAP Client SAP Client. Per your SAP install, used on: 
CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

SAP Host Host parameter for your SAPsystem. Per your SAP install, used on: 
CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

SAP Message Server SAP Message Server. Per your SAP install, used on: 
CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

SAP System ID SAP System ID. Per your SAP install, used on: 
CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

SAP Group Name SAP logon group name. Per your SAP install, used on: 
CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

SAP Gateway Server Gateway to connect to your SAPinstance. Per your SAP install, used on: 
CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

RFC Program ID Case-sensitive, uniquely-definedID in your RFC 
destination. Mustmatch that found in your 
SabrixConnection.properties file.SABRIX is 
used in this document. 

Created on:DEFINING THE RFC 
DESTINATION, SM59 

JCO Client SNC QOP Specifies the level of security in SNC, 1 to 9. 
Integration Default value is blank (disabled). Do 
not provide any value if SNC is disabled 

Per your SAP install, used on: 
CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

JCO Client SNC Name Specifies the SNC name. Integration Default 
value is blank. Do not provide any value if 
SNC is disabled. 
Canonical name of Certificate generated in 
Integration Machine. 

used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

JCO Client SNC Partner 
Name 

Specifies the SNC name of the partner. 
Integration Default value is blank. Do not 
provide any value if SNC is disabled. Canonical 
name of the Certificate generated in SAP 
Application. 

Per your SAP install, used on: 
CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

JCO Client SNC Mode Flag for activating SNC. SNC is disabled by 
default in integration. snc_mode takes values 0 
(Enabled) or 1 (Disabled). Integration Default 
value is 0 (Disabled). 

Per your SAP install, 
used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 
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JCO Client SNC SSO Flag for activating SNC SSO. SNC SSO is not 

supported in Integration and its value is always 
0 (Disabled) in Integration. Integration Default 
value is 0 (Disabled). 

used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

JCO Client SNC Library Specifies the path and file name of the SAP 
Crypto library configured in Integration Servier 
as per the Operating System. Integration 
Default value is blank. Do not provide any value 
if SNC is disabled. 

used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

JCO Server SNC QOP Specifies the level of security in SNC, 1 to 9. 
Integration Default value is blank (disabled). Do 
not provide any value if SNC is disabled 

Per your SAP install, 
used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

JCO Server SNC My 
Name 

Specifies the SNC my name. Integration 
Default value is blank. Do not provide any value 
if SNC is disabled. Canonical name of 
Certificate generated in Integration Server. 

used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

JCO Server SNC Mode Flag for activating SNC. SNC is disabled by 
default in integration. snc_mode takes values 0 
(Disabled) or 1 (Enabled). Integration Default 
value is 0 (Disabled). 

used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

JCO Server SNC Library Specifies the path and file name of the SAP 
Crypto library configured in Integration Server 
as per the Operating System. Integration 
Default value is blank. Do not provide any value 
if SNC is disabled. Install SAP Crypto Library in 
Integration Server. Provide full control user 
privileges to this SAP Crypto Library folder for 
Windows User "Local Service" if integration is 
installed in Windows. The default is the system- 
defined library as defined in the environment 
variable SNC_LIB. 

used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 
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Information About your SAP Implementation 

Item Description Page Reference 
Calculation URL The URL of the Calculationservlet. 

Example: 
http://<server:port>/sabrix/xmlinvoice 

Used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

Address Validation 
URL 

The URL of the Address Validation servlet. 
Example: http://<server:port>/sabrix/addre 
ssvalidation 

Used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

Version URL The URL of the Version servlet. Example: 
http://<server:port>/sabrix/version.txt 

Used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

Debug Level ALL, INFO, ERROR, DEBUG, or OFF Used on: SETTINGTHE LOG 
LEVEL 

Integration Log File 
Location 

Specifies the log directory and the log file name. Used on: CONFIGURING THE 
APPENDER 

Number of RFC 
Servers to Start 

To achieve multi-threading atleast two servers 
should be started. The default is 5. 

Used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

Number of Address 
Records to Return 

Limits the number of address records returned by 
the jurisdiction lookup. Default is set to 99 which 
is max SAP can return. 

Used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

Product Code to 
be Used for Freight 

Default is FREIGHT. Used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 

Fully Qualified Host 
Name 

The SAP Host to connect to. Used on: CONFIGURING 
INTEGRATION PROPERTIES 
FILE 
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Information About your SAP Implementation 

Item Description Page Reference 
Solution Manager 
URL 

URL address to access the Solution 
Manager. See your Basis person for correct 
URL 

Used on: REGISTERING 
INTEGRATION FOR SAP WITH SAP 
SOLUTION MANAGER 

Solution Manager 
Port 

Default is 50000 Used on: REGISTERING 
INTEGRATION FOR SAP WITH SAP 
SOLUTION MANAGER 

Solution Manager 
Login 

Default is j2ee_admin Used on: REGISTERING 
INTEGRATION FOR SAP WITH SAP 
SOLUTION MANAGER 

Solution Manager 
Password 

password tied to SolutionManager Login. Used on: REGISTERING 
INTEGRATION FOR SAP WITH SAP 
SOLUTION MANAGER 
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SYSTEM PREREQUISITES 

The installation of Integration for SAP places no new software or hardware requirements on either 
the system hosting SAP or the one hosting Determination. 

 
SAP System requirements are: 

 
 

SAP Basic Version 
5.2.x.x 

Dependencies XML Schema Version G 

 
ERP Version 

 
SAP ERP 6.0 and S/4 HANA 1511 and above SAP Certified 

CRM 7.0 and higher 
SAP Certified 

 
SAP-JCo, SAP Crypto, 
SRM/EBP 

JVM 8 
SAP-Jco 3.1.x 
SAP Crypto 

SRM/EBP Not Supported 
 
 

When selecting the JCo, only select the 64-bit version if a 64-bit JVM is installed. The 
version of the JCo is not related to the bit version of the operating system installed on the 
server; the JCo version is only relevant to the bit version of the JVM (Java Virtual 
Machine). 

 
 
 

For detailed platform and end of service information, please review these documents: 

Platform Guide: 

https://customer.sabrix.com/cgi-bin/sabrix.cfg/php/enduser/std_adp.php?p_faqid=527 

End of Service: 

https://customer.sabrix.com/cgi-bin/sabrix.cfg/php/enduser/std_adp.php?p_faqid=679 

https://customer.sabrix.com/cgi-bin/sabrix.cfg/php/enduser/std_adp.php?p_faqid=679
https://customer.sabrix.com/cgi-bin/sabrix.cfg/php/enduser/std_adp.php?p_faqid=527
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REFERENCES TO RELATED DOCUMENTATION 

 
ONESOURCE INDIRECT TAX-PROVIDED DOCUMENTATION (INTEGRATION FOR 
SAP) 

ONESOURCE Indirect Tax Integration for SAP US/CA Tax Configuration Guide 
 

Once you are done with the installation and basic configuration in SAP and have enabled RFCs 
from SAP to communicate with Determination, you will be using the configuration guide to enable 
US/CA transactions in SAP to communicate with Determination for tax calculation. 

 
This guide provides details on setup, configuration, and coding necessary to enable US/CA tax 
calculations with SAP. 

 
SAP Load Balancing and Failover Guide 

 
This document outlines what you should take into account when building a scalable and redundant 
architecture using Determination and Integration for SAP. The document, SAPLoadBalancing.pdf, 
can be found in the release distribution file. 

 
SAP-PROVIDED DOCUMENTATION (SAP TAX INTERFACE) 

SAP R/3 Tax Interface Configuration Guide 
 

ONESOURCE Indirect Tax Determination provides the essential steps for you to send SAP tax- 
relevant transactions in SD, MM and FI to Determination for tax calculation. These steps are 
contained in the basic manuals: ONESOURCE Indirect Tax Integration for SAP Installation and 
RFC Configuration Guide and ONESOURCE Indirect Tax Integration for SAP US/CA Tax 
Configuration Guide. 

 
However, some users find that their business requires more complex configurations. If your 
situation requires you to seek additional information about preparing SAP ECC for the external tax 
engine, consult the R/3 Tax Interface Configuration Guide Release 4.6x released by SAP Labs. 
This document should be downloaded from the SAP web page according to instructions in OSS 
note 392696, or it can be obtained from ONESOURCE Indirect Tax upon request. Although this 
guide was first published for release 4.6 in 2003 it is still applicable for ECC 6.0. We strongly 
recommend you read this document prior to configuring SAP. It will give you a broader 
understanding of the process. 

 
REVIEWING SAP SUPPORT NOTES 

We recommend that you review all relevant notes to the SAP Tax Interface on the SAP Support 
Web. Our Professional Services team has compiled a list of important OSS notes that they have 
encountered in their support of new ONESOURCE Indirect Tax implementation projects. 

 
Please review KB. 

https://customer.sabrix.com/app/answers/detail/a_id/1122  

It is a list of known possible notes relevant to integrating SAP and ONESOURCE with SAP. It is 
also recommended that you do a search in SAP at http://service.sap.com/notes for tax relevant 
notes in the core Application Areas XX-PART-TIF, CRM-BF-TAX, AP-TTE, but there are others 
relevant as well. 

http://service.sap.com/notes
https://customer.sabrix.com/app/answers/detail/a_id/1122
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INTEGRATION OVERVIEW 
This chapter describes: 

 
• The benefits of integrating SAP with Determination 
• An architectural overview and process flow 
• The various user processes that can trigger Determination tax calculations 
• Optional customizations that help you make the most of Determination 
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BENEFITS 
Enabling Determination to generate tax results for your SAP transactions results in the following 
key benefits: 

Seamless Integration. 

Once integrated, your tax professionals can continue to use SAP functionality without needing to 
learn new technology or processes. Determination automatically obtains a complete set of data 
elements necessary to perform the appropriate sales and use tax calculations, then returns the 
results to SAP—all without the need for manual intervention. 

Accurate Tax Calculation. 

Determination is the premier solution for your Sales, Use Tax and VAT needs. Determination is the 
only system to provide all of these features: 

• Integrates worldwide tax calculation.
• Enables global visibility and real-time transactions.
• Gives control of the data and decision-making to the tax professional.
• Eliminates or minimizes IT involvement as tax jurisdictions, rates, and rules change.
• Provides a scalable, maintainable enterprise solution.

Using Determination as your global transaction tax management solution reduces costs, increases 
accuracy, and provides the flexibility needed to adapt to an ever-changing business and taxation 
environment. 

Auditing/Reporting. 

Tax calculations that are processed using Determination are stored in Determination audit tables. 
From this audit data, you can generate standard or customized reports based on any user-defined 
criteria. For example, you can create tax-by-jurisdiction reports or any other desired reports 
needed to satisfy your company’s needs. 
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ARCHITECTURE 
Integration for SAP consists of a set of Java classes. These classes use the SAP Java Connector 
(JCo) interface to communicate with SAP, and the Java Connection interface to communicate with 
Determination. Additionally, these classes map data between formats that can be recognized by 
SAP and by Determination. 

Communication between SAP and ONSOURCE Indirect Tax during tax-relevant processes is 
managed by Integration for SAP. Using the JCo Server architecture, in which Integration 
subscribes to the SAP system with a predefined server pool, it makes these connections available 
to the RFC Destination at a tax call. In addition, a JCo Client to Integration was added; this is used 
when Integration starts up. This JCo Client connects to the SAP system using a special 
background account (CPIC). It then interrogates the Tax RFC Structures and provides them to 
Integration to use in the JCo Server. This JCo Client connection is only used once, at the startup of 
Integration, after which it automatically closes. 
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RFC CALL FOR SAP ECC 

The following describes the process of using the RFC call for SAP ECC: 
 

1. SAP determines that it needs to call the SAP Tax Interface. 

2. Integration is listening for remote function calls from the SAP Tax Interface. 

3. SAP sends a Remote Function Call (RFC) to one of Integration’s listeners. 

4. Integration determines which RFC call in the SAP Tax Interface was requested. 

5. Integration maps the data from SAP to ONESOURCE Indirect Tax. 

6. Integration calls Determination, sending XML over HTTP. 

7. Integration receives the results from Determination. 

8. Integration maps the results to SAP RFC response structures. 

9. SAP receives the response. 
 

USER PROCESSES THAT TRIGGER DETERMINATION TAX CALCULATIONS 

This Installation and RFC Configuration Guide provides procedures needed to install and configure 
Integration to enable RFC communication with Determination. 

 
ONESOURCE Indirect Tax Integration for SAP US/CA Tax Configuration Guide enables end-to- 
end tax calculation with configuration steps completed in SAP. 

 
Once Determination is fully integrated with SAP ECC, you can automatically generate correct tax 
results during the following actions: 

 
• Processing Purchase (Procure To Pay) or Sales (Order To Cash) Transactions. 
• Logistic Invoice Verification (LIV) with posting to A/P. 
• Processing Billing Document transactions with posting to A/R. 
• Supporting address management to support jurisdiction code. 

 
 

CUSTOMIZING INTEGRATION 
The standard out-of-the-box installation of Integration enables basic transaction data from RFCs to 
be passed to Determination, which calculates the appropriate tax and returns the correct result to 
SAP ECC RFCs. 

 
However, there are additional customizations that you can make to both Determination and SAP 
that will enable you to pass additional data to Determination to trigger specialized calculations or 
enable additional auditing or reporting capabilities. These customizations can be straightforward or 
complex and require you to thoroughly analyze your business processes and requirements. You 
can engage ONESOURCE Indirect Tax Professional Services to assist you in this process. 

 
For more information on customizing Integration, see ONESOURCE Indirect Tax Integration for 
SAP US/CA Tax Configuration Guide. 
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CONFIGURE SAP TO ALLOW CALLS TO 
COMMUNICATE WITH DETERMINATION 

 
 

Before installing Integration for SAP, you must configure SAP to use Determination to calculate 
and return tax to all tax applications. All necessary configuration steps for SAP are described in 
detail in several documents released by SAP Labs in REFERENCES TO RELATED 
DOCUMENTATION 

 
This chapter describes the minimum ONESOURCE Indirect Tax for SAP configuration you must 
complete before you install Integration. See: 

 
• DEFINING A CPIC USER ACCOUNT 
• DEFINING THE RFC DESTINATION, SM59 
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SAP ECC CONFIGURATION 
For a seamless integration between ONESOURCE Indirect Tax and your SAP ECC RFCs, you 
must configure the following: 

• Defining a CPIC user account
• Defining the RFC destination SM59

DEFINING A CPIC USER ACCOUNT 

The JCo Client in Integration for SAP requires a background user account to log on to the SAP 
system and read necessary metadata from the system. This account is only used once at 
Integration startup; it will be disconnected after the JCo Client has read the information from SAP. 

1. In the main menu, navigate to Tools > Administration > User Maintenance > SU01 -
Users; Transaction: SU01.

2. Create a new user or copy an existing one; this document uses the example SABRIX.
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 3. Navigate to the Logon Data tab. Enter a password, and make sure that the User Type is set
 to Communication or System (this picture shows a System user type.).

 4. Navigate to the Profiles tab, and add the appropriate profile. This example uses SAP_ALL,
 and SAP_NEW. Follow instructions in OSS note 460089 for more details on what
 authorization profile to use.

 5. Save your entry.
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 DEFINING THE RFC DESTINATION, SM59 

 What is an RFC Destination: Remote Function Call (RFC) is the standard SAP interface for 
 communication between SAP systems and non-SAP systems. RFC calls a function to be executed 
 in a remote system. In this step you are defining the RFC destination that will be used between 
 Determination and SAP. 

 1. In the IMG navigate to Financial Accounting > Financial Accounting Global Settings >
 Tax on Sales/Purchases > Basic Settings > External Tax Calculation > Define Physical
 Destination:

 2. Open the file folder TCP/IP Connections. Once in this folder use the Create button to add a
 new entry.
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 3. Follow the instructions given in the ECC Tax Interface Configuration Guide. You must use the
 same RFC Destination name as given in the SabrixConnection.properties file. In this guide,  
we use SABRIX as an example. Enter TCP/IP as the Connection Type, enter a Description 
1, and a Program ID in the Technical Settings tab..

 4. Optionally, maintain TRFC settings for your RFC destination as shown in the following example (Suppress 
background job if conn.error is blank, Connection attempts up to task is 5, and Time betw. 2 tries [mins] is 
0.5).

 Use top menu EDIT/ tRFC Options.

 If your system uses Unicode, you must ensure that the Unicode settings of the RFC 
 Destination are maintained accordingly. To do so, navigate to the MDMP & Unicode tab 
 and set the radio button to Unicode. 

 You must also ensure that the rfc_unicode_enable parameter is set to TRUE (default) 
 in the SabrixConnection.properties file. 
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The Special Options tab should be grayed out (unavailable): 
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Additionally, to configure SNC in the SAP system, refer to SAP documentation and setup guides 
at https://help.sap.com/ 

For activating SNC on the RFC level, the activation option is found under the Logon & Security tab. 

https://help.sap.com/
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INSTALLING AND CONFIGURING 
INTEGRATION FOR SAP 

In the previous chapter you performed the minimum configurations necessary to enable the Tax 
Interface to communicate with Integration for SAP. 

This chapter describes the process for installing, then configuring Integration software on the 
runtime system. This includes: 

• Downloading JCO
• Downloading SAP Crypto Library
• Downloading Integration for SAP
• Configuring SabrixConnection.properties file
• Configuring JAVA and JCO start up parameters
• Configuring logging options and appender
• Running Integration for SAP in the JVM
• Troubleshooting
• Registering Integration for SAP with SAP Solution Manager
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 INSTALLING ONESOURCE INDIRECT TAX INTEGRATION FOR SAP 

 DOWNLOADING JCO 

 The SAP Java Connector is used to communicate between the SAP system and other programs 
 using remote function calls (RFCs). A copy of the JCo must be installed on each system where you 
 want to run ONESOURCE Indirect Tax Integration for SAP. 

 SAP Customers can download JCo at https://support.sap.com/en/product/connectors.html. This 
 is a password- protected area for SAP customers only. Click SAP Java Connector (SAP JCo). 
 The download files are in this area by release and platform. 

 Follow the instructions given for your release and platform. See the note below about which 
 version of JCo to use. 

 When selecting the JCo, only select the 64-bit version if a 64-bit JVM is installed. The 
 version of the JCo is not related to the bit version of the operating system installed 
 on the server; the JCo version is only relevant to the bit version of the JVM (Java Virtual 
 Machine). 

 You must follow each of the steps in this section to successfully install Integration for SAP. 

 DOWNLOADING SAP CRYPTO LIBRARY 

 To enable SAP Secure network communication (SNC) between SAP Application and SAP JCO 
 Integration, set-up and configure SAP SNC in SAP Application and install SAP Crypto Library 
 and configure SNC in the integration server. 

 Download SAP Crypto Library from SAP marketplace. Navigate to URL https://support.sap.com 
 and click on Software Downloads. SAP Crypto Library is available in the SAP marketplace URL 
 for different OS Windows 64 bit, Windows 32 bit, Linux, etc. 

 Configure SabrixConnection.properties file in integration to enable JCO SNC Mode properties 
 (jco.client.snc_mode=1, jco.server.snc_mode=1) along other SNC properties as mentioned. 
 Provide full control user access privileges to this SAP Crypto Library folder for Windows User 
 "Local Service" if integration is installed on Windows. 

 DOWNLOADING INTEGRATION FOR SAP 

 1. Download the following file from the Customer Center web site
 (https://customercenter.sabrix.com/sabrixcc).

 Contact ONESOURCE Indirect Tax Technical Support if you have any questions about the
 download process.

 File Description  File Name 

 ONESOURCE Indirect TaxIntegration for 
 SAP 
 (Basic US/Canada Version) 

 ONESOURCEIDTIntegrationSAP_5220B.zip 

 2. Unzip the files into the desired directory (you may need to create it first).

 3. Copy the necessary JCo files into a separate directory or the directory to which you extracted

https://support.sap.com/en/product/connectors.html
https://support.sap.com/
https://customercenter.sabrix.com/sabrixcc
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Integration for SAP. 

For more details on JCo install please consult the SAP help files at <directory where JCo 
was extracted to>/docs/jco/intro.htm. See the Installation section for detailed instructions 
on installation and the Configuration section on troubleshooting and the runtime 
environment. 

When defining Java directories, avoid using spaces in the name because this can lead to 
errors in certain instances. 
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CONFIGURING INTEGRATION PROPERTIES FILE 

Edit the SabrixConnection.properties file found in the directory in which you unzipped the files. The 
table below lists all parameters in the properties file and their usage. 

 

ONESOURCE Indirect Tax Integration Properties File Parameters 

Attribute Description 
jco.client.user Username set up in DEFINING A CPIC USER 

ACCOUNT, (for example, SABRIX). 

jco.client.passwd Password set up in DEFINING A CPIC USER 
ACCOUNT, (for example, SABRIX). 

jco.client.ashost The SAP host to connect to. See note below. 

jco.client.sysnr The SAP system number to connect to. 

jco.client.client The SAP System Client number to connect to. 

jco.client.lang Language used to log on to SAP; set to EN for English. 

jco.client.mshost SAP Message Server. See note below. 

jco.client.group SAP Logon Group. See note below. 

jco.client.r3name SAP System ID. See note below. 

gwhost The SAP host server you like to connect to. Consult your 
SAP system administrator for help with this value. 

gwserv The SAP gateway server to connect to. Consult your SAP 
system administrator for help with this value. 

progid As defined in your RFC destination; SABRIX is used in this 
document. 

jco.client.snc_qop Specifies SNC level of security, 1 to 9.Integration Default 
value is blank. Do not provide any value if SNC is disabled. 
(Refer to value mentioned in SAP Application Server for 
snc/r3int_rfc_qop) 
Example: jco.client.snc_qop=3 

jco.client.snc_myname Specifies the SNC name. Integration Default value is blank. 
Do not provide any value if SNC is disabled. Canonical name 
of Certificate generated in Integration Server. 
Example: 
jco.client.snc_myname=p:CN=XYZ, O=MyCompany, C=US 

jco.client.snc_partnername Specifies the SNC name of the partner. Integration Default 
value is blank. Do not provide any value if SNC is disabled. 
Canonical name of the Certificate generated in SAP 
Application. 
Example: 
jco.client.snc_myname=p:CN=ABC, O=MyCompany, C=US 

jco.client.snc_mode Flag for activating SNC. SNC is disabled by default in 
integration. snc_mode takes values 0 (Disabled) or 1 
(Enabled). Integration Default value is 0 (Disabled). 
Example: jco.client.snc_mode=0 

jco.client.snc_sso Flag for activating SNC SSO. SNC SSO is not supported in 
Integration and its value is always 0 (Disabled) in Integration. 
Integration Default value is 0 (Enabled). 
Example: jco.client.snc_sso=0 
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jco.client.snc_lib Specifies the path and file name of the SAP Crypto library 
configured in Integration Server as per the Operating System. 
Integration Default value is blank. Do not provide any value if 
SNC is disabled. Install SAP Crypto Library in Integration 
Server. Provide full control user privileges to this SAP Crypto 
Library folder for Windows User "Local Service" if integration 
is installed in Windows. The default is the system-defined 
library as defined in the environment variable SNC_LIB. 
Example: jco.client.snc_lib=C:\SAPCryptolib\sapcrypto.dll 

jco.server.snc_qop Specifies SNC level of security, 1 to 9. Integration Default 
value is blank. Do not provide any value if SNC is disabled. 
Refer to value mentioned in SAP Application Server for 
snc/r3int_rfc_qop) 
Example: jco.server.snc_qop=3 

jco.server.snc_myname Specifies the SNC name. Integration Default value is blank. 
Do not provide any value if SNC is disabled. 
Canonical name of Certificate generated in Integration 
Machine. 
Example: 
jco.server.snc_myname=p:CN=XYZ, O=MyCompany, C=US 

jco.server.snc_mode Flag for activating SNC. SNC is disabled by default in 
integration. snc_mode takes values 0 (Disabled) or 1 
(Enabled). Integration Default value is 0 (Disabled). 
Example: jco.server.snc_mode=0 

jco.server.snc_lib Specifies the path and file name of the SAP Crypto library 
configured in Integration Server as per the Operating System. 
Integration Default value is blank. Do not provide any value if 
SNC is disabled. Install SAP Crypto Library in Integration 
Server. Provide full control user privileges to this SAP Crypto 
Library folder for Windows User "Local Service" if integration 
is installed in Windows. The default is the system-defined 
library as defined in the environment variable SNC_LIB. 
Example: jco.server.snc_lib=C:\SAPCryptolib\sapcrypto.dll 

SABRIX_version_url Location of Determination version file. 

SABRIX_calc_url Location of Determination xmlinvoice servlet. 

SABRIX_address_url Location of Determination addressvalidation servlet. 

SABRIX_user If calc authentication has been enabled in Determination, a 
user name and password must be defined. By default, this 
field is not used. See Appendix for further details. 

SABRIX_password If calc authentication has been enabled in Determination, a 
user name and password must be defined. By default, this 
field is not used. See Appendix for further details. 

encrypt_passwords Default setting is FALSE (do not encrypt the password). Set 
to TRUE to encrypt the password. See Appendix for further 
details. 

proxy_host In cases where you need to route Integration through a 
firewall, defining your local proxy host is required. Your 
system or network administrator can help with this setting. 

proxy_port In cases where you need to route Integration through a 
firewall, defining your local proxy port is required. Your 
system or network administrator can help with this setting. 
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ONESOURCE Indirect Tax Integration Properties File Parameters 

Attribute Description 
num_servers Determines how many instances of Integration will be 

started and registered with SAP. This is based on the speed 
of your machine and the expected processing load of SAP. 
To achieve multi-threading at least two servers should be 
started. The default is 5. 

rfc_unicode_enabled Specifies whether the SAP system uses Unicode (TRUE, 
default) or does not (FALSE). See DEFINING THE RFC 
DESTINATION, SM59 for more information. 

freight_prod_code Default product code used in Determination to determine 
freight taxability; this entry must match the freight product 
code entry in ONESOURCE Indirect Tax. 

max_jurisdiction_addresses Limits the number of address records returned by the 
jurisdiction lookup. Default is set to 99 as this is the 
maximum SAP can return to the UI. 

truncate_to_max_addresses Setting to control if error message should be raised when 
max_jurisdiction_addresses is reached (FALSE), or if 
instead the max number of addresses specified should be 
returned (TRUE). The default is FALSE. 

county_flag Controls check of state address attribute returned by 
ONESOURCE Indirect Tax during jurisdiction determination 
against SAP submitted value. If set to TRUE only matching 
entries will be returned. The default is FALSE. 

city_flag Controls check of state address attribute returned by 
ONESOURCE Indirect Tax during jurisdiction determination 
against SAP submitted value. If set to TRUE only matching 
entries will be returned. The default is FALSE. 
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ONESOURCE Indirect Tax Integration Properties File Parameters 

Attribute Description 
override_supplied_county If set to TRUE then value returned by ONESOURCE Indirect 

Tax address validation servlet will override the value 
supplied by the address master record. If set to FALSE then 
the value is not changed. The default is TRUE. 

override_supplied_city If set to TRUE then value returned by ONESOURCE Indirect 
Tax address validation servlet will override the value 
supplied by the address master record, unless the value is 
UNINCORPORATED. In that case, the SAP value will not be 
overwritten. If set to FALSE then the value is not 
changed.This parameter applies to the US only. The default 
is FALSE. 

external_company_id_prepend Prepend option for company code to uniquely define a 
company in ONESOURCE Indirect Tax (optional). 

remove_leading_zeros Enables removal of leading zeros. If set to TRUE, leading 
zeros will be removed in fields marked as such in 
LEADING ZEROS 
NOTE: This setting is for backward compatibility only and 
should not be changed from FALSE unless you are 
instructed to do so by ONESOURCE Indirect Tax Support. 

gzip_disabled The Determination Integration sends information to 
Determination via HTTP in a gzip format for performance 
improvement. For troubleshooting it might be desired to 
switch gzip off, to do so set gzip_disabled=true. Default is 
false. 

is_rounded If is_rounded set to TRUE (default), the value will be the 
document rounded amount from the output XML. 
If is_rounded set to FALSE, the value will be the document
unrounded amount from the output XML. 
NOTE: If you removed the is_rounded property, the value 
will be set to is_rounded = false. 
This is used to calculate ONLY the effective tax rate that is 
returned to SAP. It does not affect the tax amount. 

A template version of the SabrixConnection.properties file is available in the top-level 
directory to which you extracted the distribution .zip file. 

Determine if you want the connection to logon using an individual app server or if you 
want to use logon groups. In order to use logon groups, the ashost setting must be 
blank. Setting ashost will override any settings made in mshost, group, and r3name. 
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CONFIGURING JAVA AND JCO START UP PARAMETERS 

 
MICROSOFT WINDOWS 

Integration runs as a Windows Service. 
 

To install a single instance, follow these steps: 
 

1. Make sure you have configured the SabrixConnection.properties file with information specific 
to your environment. 

 
2. From Integration 5.2.1.0B, we have removed the old windows service component files 

e.g. Start.exe, Start.lax, lax.jar; and introduced a new WindowsService Component 
Apache Commons Daemon Procrun with the SabrixBasicConnection.exe and 
SabrixBasicConnectionw.exe files 

 
Refer to the Install Instructions New Windows Service Apache document 

 
 

UNIX AND LINUX 

Startup Parameters 
 

In the top level directory, find the file IntegrationServerStartup.sh and modify it according to the 
table below: 

 

IntegrationServerStartup.sh Parameters 

Variable Description 
SAP_HOME Directory for the JCo file location. The default is the 

same directory containing the .sh script. ONESOURCE 
Indirect Tax recommends that you separate the JCo 
files into a separate directory by JCo version number 
and reference that directory here. 

PROPERTIES Location for SabrixConnection.properties file. The 
default is the same directory containing the .sh script. 

SBX_PATH Directory of Integration library files. By default a /lib 
directory is created when extracting the .zip file. Do not 
change this path. 

MEMARGS Memory setting for Integration JVM. Xms and Xmx are 
the lower and upper memory allocation limits (the 
default for both is 512 MB). 

Other optional parameters: The variables below are optional and not used by 
ONESOURCE Indirect Tax, but you may opt to add them to the startup script. 
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IntegrationServerStartup.sh Parameters 

Variable Description 

JAVA_HOME The directory in which JAVA is installed. 

JCO Library LIBPATH for AIX and IBM, SHLIB_PATH for HP-UX, 
LD_LIBRARY_PATH for Sun and Linux, PATH for Windows. Consult your JCo 
install instructions for moredetail on how to set the JCo library path. 

SNC_LIB This is only required if SAP SNC is enabled. Configure SAP SNC environment 
variable. This specifies the file name of the SAP Crypto Library. 

SECUDIR This is only required if SAP SNC is enabled. Configure SAP SNC environment 
variable. This specifies the directory of the SAP Crypto Library sec folder. 

CONFIGURING LOGGING OPTIONS 

The Logger allows the information passed between SAP and Integration to be captured in log 
records to be later viewed for process debugging. The logs will show, depending on the log level 
selected, the data passed back to SAP, program information, and system error messages helpful 
in problem solving. The log level setting determines how much data is captured in the logs and the 
appender settings determine the number of log files stored and how they are updated, maintained 
and overwritten. 

The recommended process would be to set these options differently between production, test, and 
development client instances of SAP on your system. Because of the size of the log files, normally 
you would set production instances to ERROR or FATAL errors only to limit log size and storage 
constraints on your production system. DEBUG or INFO level settings produce exponentially 
larger data logs and are more appropriate for test client instances where transaction levels are 
lower and more information is needed for debugging test cases and testing system 
enhancements. Ask your ONESOURCE Indirect Tax Product Services Representative for 
recommend settings for your system environment. 

The SABRIXIntegrationServerLoggingConfig.xml file is used to configure Integration for SAP 
logging options. Integration upgraded log4j logging version and uses log4j2 library. 

This configuration file has two main components (logger and appender), which can be 
customized to meet your logging requirements. 

DEFINING LOG LEVEL AND APPENDER SETTINGS 

Configuration XML tag has status attribute and monitorInterval attribute configured. 

<Configuration status="ERROR" monitorInterval="600"> 

Configure Status attribute to log the level of internal Log4j events that should be logged to the console 
(SabrixOut.txt or startSabrixConnection.log file). Valid values for this attribute are "off", "debug", "info", 
"warn", "error", "fatal". Log4j will log details about initialization, rollover and other internal actions to the 
status logger. Setting status="debug" is one of the first tools available to you if you need to troubleshoot 
log4j. Recommend to provide status=”error” in production environment to avoid huge logs.  

Log4j has ability to automatically detect changes to the configuration file and reconfigure itself. If 
the “monitorInterval” attribute is specified on the configuration element and is set to a non-zero value, 
then the file will be checked the next time a log event is evaluated and/or logged and the 
“monitorInterval” has elapsed since the last check. The example above shows that the configuration file 
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will be checked for changes only after at least 600 seconds have elapsed. The minimum interval is 5 
seconds.  

The logger component is found towards the end of the file. For example: 

<Logger name="com.sabrix.integration" level="DEBUG" additivity="false"> 
<AppenderRef ref="CompositeRollingFileAppender"/> 

</Logger> 

Within the logger component: 

• The level attribute represents the logging level to be written to log file.
• The AppenderRef component refers to the active appender that being used for logging.

SETTING THE LOG LEVEL 

Use the level component to set the log level to any of the following: 

• DEBUG: Detail level programming messages
• INFO: Input/Output XML; Connection Info
• ERROR: Core errors/exceptions
• FATAL: VM ERRORS
• OFF: No logging enabled

For example, to set logging to the INFO level, modify the level in the logger component block as 
shown here: 

<Logger name="com.sabrix.integration" level="INFO" additivity="false">  

<AppenderRef ref="CompositeRollingFileAppender"/
> </Logger>

The AppenderRef component refers to the active appender that is being used for logging. 
There are six appenders defined in this configuration file. For a given integration, only one 
appender out of the six can be active at a time, which is reflected by the value of ref in: 

<AppenderRef ref="CompositeRollingFileAppender"/> 

Uncomment to configure the CompositeRollingFileAppender <RollingFile> 
</RollingFile> XML tag and comment the ZipRollingFileAppender XML tag 
<RollingRandomAccessFile> </RollingRandomAccessFile>.
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Each appender is enclosed in an <RollingFile> </RollingFile> block or <RollingRandomAccessFile> 
</RollingRandomAccessFile> block. 

NOTE: The ZippingFileAppender is the default used by Integration for SAP and comes pre- 
configured for the product. If you desire to use one of the other appender file formats then use one of 
the five types below. You will find additional information on how to change the configuration for the 
appender in the appendix under the section titled APPENDER FILE CONFIGURATION FOR THE 
6 APPENDER FORMATS 

Suggestion: You can direct your logs to the location of the Sabrix.log in ONESOURCE UI. This 
can be much more helpful for development and QA troubleshooting so that users can access the 
log themselves without getting access to the server where the connection is located. 

Contact your Professional Services Representative if you have multiple integration 
servers in the same environment and need assistance in redirecting the logs. 

The six appenders are: 

1. The SimpleFileAppender: Simple logging written to a file. This option has neither the ability to
perform daily log rolling, nor does it let the user specify the maximum file size for the log file.

2. The DailyRollingFileAppender: Enables daily log rolling with a date and time stamp on the log
file.

3. The CompositeRollingFileAppender: Log rolling with a date and time stamp on the logfile.
This appender also allows you to specify the maximum file size for the log file, as well as the
maximum backup number of files to keep.

4. The ConsoleAppender: Provides startup information on the console.

5. The RollingFileAppender: The rolling file appender does file size log rolling with numeric
value incremented on the logfile.

6. The ZippingFileAppender: File size log rolling with zipped output in the log directory. This is
the default appender used by Integration for SAP. This appender will roll every hour and on roll,
will zip the contents of the file.

Use the parameter filename to set the log directory to your desired location. The default is 

.log/SabrixIntegrationServer.log.

CONFIGURING THE APPENDER 
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RUNNING INTEGRATION FOR SAP IN THE JVM 

The following steps start and stop your Integration for a single server, but if you are setting up a 
system for heavy load and failover, you can also start this process on multiple computers. For 
more information on that topic, see the SAPLoadBalancing.pdf document distributed with this 
release. 

 
Follow the instructions in one of these sections based on your operating system: 

 
• Microsoft Windows 
• UNIX and Linux 

 
MICROSOFT WINDOWS 

Now that you have installed the service, start the service by using standard Windows Service 
management tools. 

 
Upon startup, the service should write startup messages to the log directory. It will create two log 
files: SabrixError.txt and SabrixOut.txt. If the service has any problems starting up, it will log it to 
one of these files. 

Once the service has been successfully started, it is ready for use. To stop the service, you can 
use the standard Windows service management tools. 

 
To uninstall the service, run the UninstallSabrix-NT.bat script provided. 

 
To install more than one instance on the same computer running Microsoft Windows: 

 
Refer to detailed instructions in the Install Instructions New Windows Service Apache document 

 
UNIX AND LINUX 

Starting Integration for SAP 
 

After you modify IntegrationServerStartup.sh file, you can execute it from a command line. To 
confirm that it has started correctly, check for the message, “Successfully initialized and accepting 
transactions” in the console. 

 
If you encounter an error message during start-up, please review the SabrixConnection.properties 
file to ensure you have entered the correct settings. 
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Stopping Integration for SAP 

To stop Integration, execute the file IntegrationServerShutdown.sh. If you are launching multiple 
instances of Integration from the same directory, this script stops only the latest process. 

If you wish to run multiple instances of Integration from the same UNIX or Linux server, 
ONESOURCE Indirect Tax recommends that you launch each from a separate directory. 
For more information, please contact ONESOURCE Indirect Tax Technical Support. 

TROUBLESHOOTING INTEGRATION FOR SAP 

This section describes how to test SAP to ONESOURCE Indirect Tax connectivity. It assumes that 
Integration has been installed correctly as shown in this chapter. 

The objective of this test is to make sure that Integration installation, Integration configurations, 
and SAP configurations are all working together and that the SAP RFCs are communicating with 
Determination through Integration for SAP. 

TESTING JCO INSTALLATION 

To check if JCo is deployed correctly, SAP provides the following JAVA commands. 

For Windows-based environments use: 

java -jar {sapjco-install-path}/sapjco3.jar 

For UNIX/Linux environments use: 

java -jar {sapjco-install-path}/sapjco3.jar -stdout 

Both commands should generate a version dialog which indicates the proper JCo installation. 
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CHECKING THE GATEWAY FOR REGISTERED PROGRAMS 

1. Log on to your SAP system and navigate to transaction SMGW for the Gateway Monitor:

Tools > Administration > Monitor > System Monitoring > SMGW - Gateway Monitor.

2. Navigate to Goto > Gateway > SNAGateway.

This step may not be necessary if there is only one gateway, but in configurations with 
multiple gateways, it switches the view to the central gateway. 

3. Navigate to Goto > Logged on clients.
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 4. On the overview screen you should see several instances of ONESOURCE Indirect Tax
 (usually, there are five instances, based on the num_servers variable in your
 SabrixConnection.properties file).

 If you do not see a connection for SABRIX, Integration for SAP did not reach the SAP 
 system you are currently logged on to and indicates that the 
 SabrixConnection.properties file settings point to a different SAP instance. Please review 
 with your system DBA. 
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TESTING THE RFC DESTINATION 

1. In the IMG navigate to Financial Accounting > Financial Accounting Global Settings >
Tax on Sales/Purchases > Basic Settings > External Tax Calculation > Define Physical
Destination.

2. In the RFC destination, click Test Connection.

Select TCP/IP connections.
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 3. A results screen should display communication speeds (this example is over a slow VPN
 network).

 An unsuccessful test would show an error message like "Connection error" or "Error when opening an 
RFC connection", and "Error: Program SABRIX not registered

 In this case, verify that all the settings in the SabrixConnection.properties file are correct and 
 that you are connected to this SAP system. 

 TESTING TAX CALCULATIONS USING TRANSACTION SE37 

 This procedure assumes that you have Determination installed and configured to include at least 
 one ONESOURCE Indirect Tax Company. If you have not, follow the steps mentioned in the 
 chapter DEFINING A COMPANY IN DETERMINATION FOR RFC TESTING and then 
 complete this procedure. 

 1. Navigate to transaction SE37 for a tax calculation test using the SAP Workbench.

 Tools > ABAP Workbench > Development > User Interface > Function Builder
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2. Use Function Module RFC_CALCULATE_TAXES_DOC and select Test or F8.

3. Enter the necessary information for control data, header, and item (the example below may
not match your system setup) and then select Execute or F8.

example of data to enter when clicking on control data icon is shown below: 
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Example of data to enter when clicking on tax calc header info icon is shown below: 

Example of data to enter on Tax_CAL_ITEM_IN icon 
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After input of the data above, hit the execute button (F8) to get the following output screen. 

See screen view below: A tax call has been successfully made to Determination if the return 
structure contains a message similar to Successful Processing RFC_CALCULATE_TAXES_DOC 
in O_COM_ERR_DOC. 

An error indicates that Determination could not be reached in the sample below, the URL for 
Determination is wrong. 
Please make sure you can reach Determination using the Internet Explorer browser and the URL. 
If you cannot reach ONESOURCE Indirect Tax Determination using Internet Explorer, then either 
Determination is not running or the URL provided is wrong. Consult with your DBA. 
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CHECKING VERSION COMPATIBILITY 

Structure O_EXT_CONTROL_DATA includes detailed information on versions of software that the 
SAP Integration uses. 

Field Description 

API_VERSION Release of Integration for SAP delivered by ONESOURCE Indirect Tax. 
(Example: 5.2.2.1B) 

SYST_VERSI Determination version. (Example: 9.13.0.174) 

DB_VERSION Version of the SAP JCo (Java Connector) provided by SAP for 
Integration. (Example: 3.1.3) 

RESOLVING INSTALLATION ERRORS 

If you followed the above test sequence and all tests were successful, you have confirmed that 
communication between SAP and ONESOURCE Indirect Tax is established and works properly. 

If there are any issues with connection results, please verify the settings in the document list 
outlined in the note below. If this situation persists, follow the note instructions below. 

In case of a repeated unsuccessful start, please open a support ticket with 
ONESOURCE Indirect Tax and attach the following files or contact your Professional 
Services Representative. 

• SABRIXConnection.properties
• SABRIXIntegrationServerLoggingConfig.xml
• SABRIXError.txt (if running on Windows)
• SABRIXOut.txt (if running on Windows)
• SabrixBasicConnection.yyyy-mm-dd.log (if running on Windows)
• InstallSabrix-NT.bat (if running on Windows)
• UninstallSabrix-NT.bat (if running on Windows)
• IntegrationServerStartup.sh (if running on UNIX/Linux)
• Nohup.out (if running on UNIX/Linux)
• SabrixIntegrationServer.log
• startSabrixConnection.log ((if running on UNIX/Linux))



42 INSTALLING AND CONFIGURING INTEGRATION FOR SAP 
INSTALLING ONESOURCE INDIRECT TAX INTEGRATION FOR SAP 

ONESOURCE INDIRECT TAX INTEGRATION FOR SAP INSTALLATION 
AND RFC CONFIGURATION GUIDE - VERSION 5.2.2.1B 

 

 

 
REGISTERING INTEGRATION FOR SAP WITH SAP SOLUTION MANAGER 

1. Log on to the server where Integration for SAP is installed. 

2. Execute one of these batch files: 

• SolutionManagerSubmit.bat on Windows or 
• SolutionManagerSubmit.sh on UNIX/Linux. 

 
3. Enter the URL for the Solution Manager. 

4. Refer to the table in Solution Manager Port 

5. Enter your settings for the following fields (the last three rows of the table): 

• Port (normally 50000). 
• User ID. 
• Password. 



INSTALLING AND CONFIGURING INTEGRATION FOR SAP 
INSTALLING ONESOURCE INDIRECT TAX INTEGRATION FORSAP 

43 

ONESOURCE INDIRECT TAX INTEGRATION FOR SAP INSTALLATION 
AND RFC CONFIGURATION GUIDE - VERSION 5.2.2.1B 

DEFINING A COMPANY IN DETERMINATION 
FOR RFC TESTING 

This chapter describes the required steps to configure Determination after installing Integration. 
See: 

• CREATING A COMPANY
• MAPPING A COMPANY TO A SAP COMPANY CODE
• SELECTING TAX DATA PROVIDERS

For information about additional configuration to further customize your integration, see 
CUSTOMIZING INTEGRATION 
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 ONESOURCE INDIRECT TAX DETERMINATION CONFIGURATION 
 On Determination side, you need to: 

 • Create the appropriate companies to map to SAP (this page). This might be a single
 company or multiple companies associated with each SAP Company Code for whichyou
 would like ONESOURCE Indirect Tax to calculate tax. You may want to create a single
 company for testing purposes only.

 • Select the correct Tax Data Provider for each company.

 CREATING A COMPANY 

 The following is a brief process for creating companies in Determination. For complete information, 
 see Determination Help. 

 If you will be running transactions through a company that has already been created, skip to the 
 next section. 

 1. Log into Determination as the dba for your implementation.

 2. Navigate to System > Companies.

 3. Click Add.

 4. Enter identifying information for the company, including its name, short name, parent
 company, and home menu URL.

 5. Click Submit.

 Next, configure the External Company ID as shown in the following section. 
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MAPPING A COMPANY TO A SAP COMPANY CODE 

When transaction data (in the form of input XML) is passed into Determination an XML element tag 
determines which company’s rules, rates, and other processing logic are applied. The 
<External_Company_ID> tag is set on the Companies Edit page for a selected company in 
Determination. The name you enter here corresponds to the SAP company code sending tax 
transactions. 

Set the External Company ID 

1. In Determination, select the desired company and navigate to the Companies Edit page.

2. Enter the External Company ID and click Submit.

If your implementation makes use of the optional .properties parameter 
external_company_id_prepend, then your external company ID will be a concatenation of 
the value of external_company_id_prepend plus the SAP company code. 

SELECTING TAX DATA PROVIDERS 

Determination tax data providers maintain data such as rules, rates, and product exceptions. The 
Sabrix INTL Tax Data provider contains special tax codes that enable integration with SAP for 
Canadian & Global transactions while Sabrix US Tax Data provider contains rates and rules for US 
transactions. 
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 Select the correct tax data provider(s) 

 1. In Determination, select the desired company and navigate to the Tax Preferences page.

 2. Select SABRIX US Tax Data as the US Tax Data Provider and SABRIX INTL Tax Data as
 the International Tax Data Provider.

 3. Click Submit to save your settings.
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ADVANCED CONFIGURATIONS IN 
INTEGRATION FOR SAP 

In order to meet new tax challenges, we have provided additional means to evaluate transactions 
and calculate tax. The improvements have lead to more complexity in both Determination and 
Integration software for SAP. To help you take advantage of the new capabilities, we have 
introduced Advanced Configurations within Integration software. 

When you install Integration for SAP, ONESOURCE Indirect Tax provides preset Basic 
Configuration settings so you can calculate tax quickly. If you have a business requirement for one 
of the functions below, Advanced Configuration settings supports these needs. 

Similar to Determination concept of Tax Data Provider (TDP) and Custom Data Provider (CDP) 
data, the advanced configuration settings you enable in Integration for SAP will append, augment, 
or override the standard settings built and shipped with Integration for SAP. 

The following areas are supported in Advanced Configurations: 

• Custom Authorities
• Jurisdiction Determination and Address Mapping
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 CUSTOM AUTHORITIES 
 You can create custom authorities to extend the functions of Determination by managing 
 transaction tax scenarios that are industry or company specific. When using custom authorities, 
 Integration for SAP receives tax results in addition to the regular Sales and Use Tax or VAT. These 
 taxing authorities must be managed and mapped by Integration for SAP. 

 To do so, the taxMappingsExtension.xml configuration file is provided in Integration for SAP 
 distribution. This file configures how tax results are returned to SAP. The purpose of this file is to 
 manage authorities not already mapped by ONESOURCE Indirect Tax, but you may opt to 
 override the standard mappings in this file as well. 

 Changes to any of the Advanced Configuration files require that you stop and restart Integration for 
 SAP for the changes to take effect. 

 TAXMAPPINGSEXTENSION.XML 

 The taxMappingsExtension.xml file has several sections: 

 • taxFilters: defines which tax results from ONESOURCE Indirect Tax are not returned to
 SAP. (Not applicable for US/CA.)

 • taxVatAdjustments: defines which tax results have to be returned as a negative value to
 SAP. This is to support Input/Output transactions. (Not applicable for US/CA.)

 • taxJurisdictionLevels: defines what tax is returned to which SAP tax/pricing condition
 based on the SAP field TXJLV (Tax jurisdiction code level) in the RFC structure.

 • taxOverrides: defines how taxes are sent to ONESOURCE Indirect Tax during a FORCE
 transaction.

 • buyerRoleSwitches: describes the buyerRoleSwitches section of
 taxMappingExtensions.xml.

 With the exception of the taxOverrides, the following Output XML fields from the <LINE>.<TAX> 
 block can be used in the taxMappingsExtension.xml file: 

 • <AUTHORITY_NAME>
 • <AUTHORITY_TYPE>
 • <EFFECTIVE_ZONE_LEVEL>
 • <TAX_DIRECTION>
 • <TAX_RATE_CODE>
 • <TAX_TYPE>
 • <TAXABLE_COUNTRY>

 ONESOURCE Indirect Tax includes a sample taxMappingsExtension.xml file in Integration for 
 SAP distribution .zip file. 
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TAX JURISDICTION LEVELS 

This section assigns taxes relevant for SAP to the appropriate tax jurisdiction code level (TXJLV) 
in the RFC structure, which then is returned to the calling application’s pricing procedure (SD) or 
tax procedure (MM/FI). SAP ships with up to six condition types defined for six tax jurisdiction code 
levels, but can support up to 10 tax jurisdiction code levels. Integration for SAP takes advantage of 
these additional levels as needed. 

Standard mapping relevant for the taxing country. This is the standard setup when Integration 
for SAP is installed. All tax results are mapped according to the standard mapping rules outlined 
below: 

Geography 

Level United States Canada 
1 State Sales & Use Tax Country (GST) 

2 County Sales & Use Tax Province (PST) 

3 City Sales & Use Tax Country (HST) 

4 Local Sales & Use Tax (County) Province (QST) 

5 Local Sales & Use Tax (Others) Country (GST) 
Non-Recoverable 

6 Not Used Not used 

All other levels Not Used Not used 

The Canadian Authority Types are: 

• GST: Goods and Service Tax
• PST: Provincial Sales Tax
• HST: Harmonized Sales Tax
• QST: Quebec Sales Tax

Custom configuration always takes precedence. Therefore, if you previously used these 
jurisdiction levels in taxMappingsextension.xml file for another purpose, these mappings will not be 
in effect. Modify the taxMappingsextension.xml file to assign these taxes to appropriate jurisdiction 
levels in SAP. 
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Custom Authority tax results can be returned to SAP tax jurisdiction code levels other than those 
shown in the standard mapping table. 

For example, ONESOURCE Indirect Tax uses tax jurisdiction code levels XR1 to XR5 in the US. 
Conditions XR6 to XR0 could be used to map custom authorities. This allows up to five additional 
tax levels to be used for custom authorities. A sample mapping is outlined in the table below. 

Override the standard ONESOURCE Indirect Tax mapping. If you want to override the 
standard mapping, you can do so in this file. Custom definitions always take precedence over 
defined mappings. Therefore, you could opt to return all US Sales and Use taxes into one tax 
jurisdiction code level (for example XR1) and use the remaining for custom authority mappings. A 
sample of such mapping is outlined in the table below.The examples shown are for the United 
States. 

Custom Mapping 

Level Standard Mapping 

Scenario 1 - 
Custom 
Authorities 
based on 
standard 

Scenario 2 - 
Custom 
Authorities into 
additional levels 

Scenario 3 - 
Custom 
Authorities 
Free-From 
mapping 

1 State Sales & Use Tax State Sales & Use 
Tax 

State Sales & Use 
Tax 

All Sales & Use Tax 

2 County Sales & Use 
Tax 

County Sales & 
Use Tax 

County Sales & 
Use Tax 

Custom Authority 

3 City Sales & Use Tax City Sales & Use 
Tax 

City Sales & Use 
Tax 

Custom Authority 

4 Local Sales & Use 
Tax Zone County 

Local Sales & Use 
Tax Zone County 

Local Sales & Use 
Tax Zone County 

Custom Authority 

5 Local Sales & Use 
Tax others Taxes 

Local Sales & Use 
Tax others 

Local Sales & Use 
Tax others 

Custom Authority 

6 not used not used Custom Authority Custom Authority 

7 not used not used Custom Authority Custom Authority 

8 not used not used Custom Authority Custom Authority 

9 not used not used Custom Authority Custom Authority 

0 not used not used Custom Authority Custom Authority 

Where multiple authorities exist at the same level and the taxable basis is the same, Integration 
returns the summed tax amount and the summed tax rate, where the tax amount is not equal to 
zero. The exempt amount is calculated using the gross amount less the taxable basis. 

Where multiple authorities exist at the same level and the taxable basis is different, Integration 
returns the highest taxable basis where the tax amount is not equal to zero. The tax amount is 
summed and the tax rate is calculated using the summed tax amount divided by the highest 
taxable basis. The exempt amount is calculated using the gross amount less the highest taxable 
basis. 
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 TAX OVERRIDES 

 When taxes are posted to SAP, several authorities are combined into one SAP tax jurisdiction 
 code level, if they fall into the same authority type and zone level mappings. At the time of a 
 FORCE transaction from SAP, Integration for SAP places these tax results back into the 
 appropriate authorities. This section of the XML file enables this placement. The following 
 indicators can be mapped and determine which SAP tax jurisdiction value is posted to 
 ONESOURCE Indirect Tax Input XML <LINE>.<OVERRIDE_AMOUNT>: 

 • isCountry
 • isProvince
 • isState
 • isCounty
 • isCity
 • isDistrict
 • isPostcode
 • isGeocode

 The values listed above correspond to Determination effective tax level definitions without the 
 prefix is on an authority. 

 There are three variables for the definition: 

 • ShipTo_Country: SAP country to determine rule for overrides.
 • jurisLevel: SAP tax jurisdiction level the tax amount comes from.
 • <variable from above list>: For example, isCountry would place the value from the

 corresponding SAP tax jurisdiction into the <LINE>.<OVERRIDE_AMOUNT>.<COUNTRY>
 XML tag.

 Changes to the standard mapping provided by the Advanced Configuration setup are supported by 
 ONESOURCE Indirect Tax at a technical level. However, as with all ONESOURCE Indirect Tax 
 functionality, we cannot take responsibility for any business or taxing implications which might 
 result from mapping on your system. Thoroughly test any configurations to confirm that they 
 provide the desired results before going into production. Testing should include all types of RFC 
 calls from SAP, including RFC_CALCULATE_TAXES_DOC, RFC_UPDATE_TAXES_DOC, and 
 RFC_FORCE_TAXES_DOC. 

 To confirm that your accounting needs are satisfied, we recommend that you thoroughly test end- 
 to-end your order-to-cash and procure-to-pay processes to make sure that tax results generated by 
 custom configurations are posting correctly to your G/L accounts. 
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BUYER ROLE SWITCHES 

This section describes the buyerRoleSwitches section of taxMappingExtensions.xml. 

For some authorities in the US and US Territories, only a sales tax rate has been defined. 
Therefore, anytime a purchase-based transaction is run, use tax will not calculate. This means that 
for the AP side, we need Determination to run the transaction as a seller when doing a vendor 
validation. By running the transaction as a seller we will capture the correct taxes. Integration for 
SAP will switch the Buyer and Seller role for the combinations below. 

• ShipFrom_Country: country of the ship-from jurisdiction code.
• ShipTo_Country: country of the ship-to jurisdiction code.
• switch: true or false value used to trigger switching of role

Ship From Country Ship To Country 
US (United States) US (United States) 

PR (Puerto Rico) PR (Puerto Rico) 

AS (American Samoa) AS (American Samoa) 

VI (Virgin Islands (U.S.)) VI (Virgin Islands (U.S.)) 

GU (Guam) GU (Guam) 
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JURISDICTION DETERMINATION AND ADDRESS MAPPING 
Jurisdiction Codes are retrieved from ONESOURCE Indirect Tax during the creation or change of 
any master record that has an address. A Remote Function Call from the SAP Tax Interface 
System is then made to the addressvalidation servlet which evaluates the Zone Tree. The results 
are sent back to SAP through the SAP Tax Interface System in the form of a Jurisdiction Code. 
The Jurisdiction Code is stored on the SAP master record. 

The SAP Jurisdiction Determination function calls the servlet to find the most accurate jurisdiction, 
given the information in the transaction. The system behavior is based on the country in which the 
transaction takes place, and in some cases, is based on the information provided. 

Basic behavior for all countries except United States of America: 

All SAP address elements provided in the RFC_JURISDICTION_CODE are sent to ONESOURCE 
Indirect Tax for Zone Tree evaluation. ONESOURCE Indirect Tax will return all found zones andtheir 
appropriate Jurisdiction Codes to the SAP system. In the case where there is more than onezone 
returned, ONESOURCE Indirect Tax default zone is the top row entry. 

Special behavior for United States of America: 

ONESOURCE Indirect Tax does not store every ZIP Plus 4 (Geocode) in the United States. It only 
stores Plus 4 data that affects taxability. The return behavior of the addressvalidation servlet 
depends on whether 5-digit ZIP or 9-digit ZIP Plus 4 information is sent. 

If only 5-digit ZIP information is sent to the servlet, all possible jurisdiction choices are returned to 
SAP so you can determine the appropriate address for the master data record. The default zone is 
always the first record returned. 

If ZIP Plus 4 information is sent to the servlet, it always returns only one jurisdiction code to SAP: 

• If ONESOURCE Indirect Tax stores the Plus 4 value, only one Jurisdiction Code is
returned.

• If ONESOURCE Indirect Tax does not store the Plus 4 value, the Jurisdiction Code returned
represents ONESOURCE Indirect Tax default zone for that area. This is always the correct zone.

ONESOURCE Indirect Tax strongly suggests sending ZIP Plus 4 address information for 
best tax accuracy. 

CITY/COUNTY MATCHING LOGIC 

Integration for SAP has four .properties parameters that support matching for United States of 
America transactions only. These parameters assist in data consistency and provide additional 
benefits when evaluating the Zone Tree. The parameters are: 

• city_flag
• override_supplied_city
• county_flag
• override_supplied_county
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city_flag: If the parameter is set to TRUE, an address returned by ONESOURCE Indirect Tax is 
discarded if the city name does not match the city name in the address provided by SAP. If 
ONESOURCE Indirect Tax returned one or more addresses, but they were discarded because of 
city name matching, an error is returned to SAP. A null value supplied by SAP always matches a 
value returned by ONESOURCE Indirect Tax, regardless of the string match setting. 

The city UNINCORPORATED always matches, even if the city_flag is set to TRUE. If the 
flag is set to FALSE, no matching is performed between ONESOURCE Indirect Tax 
Determination cities and SAP provided cities. 

override_supplied_city: IF set to FALSE, then the value supplied by SAP is returned; if set to 
TRUE the value returned by the address validation servlet is used, unless the value is 
UNINCORPORATED. In that case, the SAP value will not be overwritten. Default is FALSE. 

county_flag: If the parameter is set to TRUE, an address returned by ONESOURCE Indirect Tax 
Determination is discarded if the county name does not match the county name in the address 
provided by SAP. If ONESOURCE Indirect Tax returned one or more addresses, but they were 
discarded because of county name matching, an error is returned to SAP. A null value supplied by 
SAP is not evaluated for a match. If the flag is set to FALSE, no matching is performed between 
counties and SAP provided counties. 

override_supplied_county: If the parameter is set to FALSE, the county supplied by SAP is 
returned. A null value from SAP will not return a value to SAP. If the parameter is set to TRUE, the 
county found in ONESOURCE Indirect Tax Determination Zone Tree is returned to SAP and the 
address is supplemented with that information. If county_flag is set to TRUE, the value supplied by 
SAP is the value returned by Determination. 

TAX JURISDICTION CODE BREAK-DOWN 

United States Structure (for example, procedure TAXUSX) 

TAXJCD_L1 TAXJCD_L2 TAXJCD_L3 TAXJCD_L4 
USA Country & State (4) Zip Code (5) Location (4) Indicator (1) 

Sample USNY 14744 8703 0 

Explanation The two character The five digit US The four digit US The indicator on 
country code and zip code. plus four data. *If whether the 
two character US null, address is located 
state combined. ONESOURCE within or outside 

Indirect Tax 
changes to XXXX 

city limits. 0 = in 
city, 1 = out of city. 

as a placeholder. 
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ONESOURCE Indirect Tax Determination uses XXXX as the placeholder for a null Plus 4 
because 0000 and 9999 are valid Plus 4s in the United States. SAP requires data in 
those positions and does not allow XXXX as a valid Plus 4. 

Canada Structure (for example, Procedure TAXCAX) 

TAXJCD_L1 TAXJCD_L2 TAXJCD_L3 TAXJCD_L4 
Canada Country (2) Province Code (2) Not Used (0) Not Used (0) 

Sample CA BC 

Explanation The two character 
country code for 
Canada. 

The two character 
province 
abbreviation. 
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ENABLING CUSTOM ATTRIBUTES 

The SAP Standard Tax Interface provides predefined structures containing fields sent to the 
external tax system for tax calculation. These fields are usually enough to calculate standard tax 
scenarios. But when trying to solve the most complex tax requirements, the SAP Standard Tax 
Interface has considerable shortcomings. 

To bridge that gap, ONESOURCE Indirect Tax allows 40 additional fields to be appended to the 
SAP system for tax calculation. The additional fields are mapped to Determination as Input XML 
Custom Attributes. Integration for SAP already includes the fields. You must maintain the Tax user 
exit to fill the new tax-relevant fields in the appended structures, and use TransEditors or Rule 
Qualifiers to either map the resulting Custom Attributes fields to relevant Input XML elements or 
trigger rule selection to ensure proper calculation. 

This chapter provides an overview of the tax process and user exits, explains how to append the 
SAP Standard Tax Interface, and describes a use-case involving TransEditors and Rule Qualifiers. 

• TECHNICAL OVERVIEW
• PHYSICAL OVERVIEW
• TAX PROCESS OVERVIEW
• APPENDING THE SAP TAX INTERFACE
• POPULATING DATA FIELDS WITH THE USER EXIT
• TESTING RFCS WITH ADDED CUSTOM ATTRIBUTES

ONESOURCE INDIRECT TAX INTEGRATION FOR SAP INSTALLATION 
AND RFC CONFIGURATION GUIDE - VERSION 5.2.2.1B 
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TECHNICAL OVERVIEW 

TECHNICAL OVERVIEW 
To better understand the magnitude and complexity of the proposed change to an SAP system, 
you must understand SAP's change management system. SAP separates changes to their system 
into the following categories: 

System Configuration: Business-specific definitions to uniquely represent a company's structure, 
processes and entities using the IMG (Implementation Guide) within SAP as part of a system 
implementation. Fully supported by SAP. 

System Enhancements / Appends: Change made to an SAP system for a particular customer 
requirement using a predefined place within the SAP processing logic (user exit in ABAP code, 
APPEND in tables, structures, etc.). SAP guarantees upward compatibility and never overwrites 
the enhancements if performed according to SAP recommended guidelines. 

System Modifications: Change to an SAP repository object altering core code or structures. 
Modifications have to be reviewed, and where necessary, adapted during an upgrade. 
Modifications are not supported by SAP. 

Changes to support the 40 additional attributes described in this chapter are included in the 
“System Enhancements / Appends” category and are therefore fully supported by SAP. These 
enhancements strictly follow SAP guidelines. 
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PHYSICAL OVERVIEW 
The implementation of the append consists of a newly created structure containing the 40 
additional fields, their definitions, and their descriptions. This structure is then appended as an 
include structure to the three SAP Standard Tax Interface structures as well as to two additional 
tables used internally by the SAP system during the tax call. 
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TAX PROCESS OVERVIEW 
Each business transaction is checked for tax relevancy. If tax needs to be calculated, SAP starts 
the collection process. At that point, the Tax user exit EXIT_SAPLFYTX_USER_001 is called and 
any custom code runs. Within the user exit, only fields listed in the TAX_ALLOWED_FIELDS 
structure can be used with the tax interface. Business transaction data as well as other stored data 
can be accessed and mapped in the user exit. 

After successful collection, SAP copies the collected data, including customer specific data in the 
APPEND structure, into the RFC structure that communicates with the external tax software. The 
call to Integration for SAP is made and ONESOURCE Indirect Tax determines tax based on the 
SAP-supplied fields. ONESOURCE Indirect Tax returns tax results, using Integration for SAP, to 
the SAP business application. 
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 APPENDING THE SAP TAX INTERFACE 
 This section describes the steps to append the SAP Tax Interface. Follow these instructions 
 carefully to ensure a successful configuration. 

 We have provided a transport to aid in this process. 

 1. Import the package transport. The transport is stored in K900186.DO2 and R900186.DO2.

 ONESOURCE Indirect Tax Integration for SAP - 40 Input User Attributes 

 For upgrade customers transports may need to be imported with the "Overwrite 
 Originals" check box selected when importing the transport. In cases where a 
 customer already has prior existing objects setup in their development system and they 
 import a transport into their development system which alters these objects an error is 
 raised during the import if the “Overwrite Original” box is not checked. 

 See appendix section at the end of this installation guide for information on locating transports, 
 loading information, and verification data. 

 After applying this transport, you will have the following items added to your system: 

 • Package Z_Sabrix_Connector
 • Newly created structure ZUSERELEMENTS_ITEM that includes 40 new customer

 attributes.
 • Appended SAP Tax Tables. The following table lists the SAP tables that are now appended

 and within the appends, inclusion of the new ZUSERELEMENTS_Item Structure.
 . 

 SAP Tables to Append 

 Component  Append  Append Name 
 TAX_CAL_ITEM_IN00  ZATAX_CAL_ITEM_IN00  Sabrix Append 

 TAX_UPD_ITEM_IN00  ZATAX_UPD_ITEM_IN00  Sabrix Append 

 TAX_FRC_ITEM_IN00  ZATAX_FRC_ITEM_IN00  Sabrix Append 

 TAX_USER_INF  ZATAX_USER_INF  Sabrix Append 

 TAX_ALLOWED_FIELDS  ZATAX_ALLOWED_FIELDS  Sabrix Append 
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 CONVERTION OF SAP DB TABLE ETXDCI. 

 During activation of append structure ZATAX_USER_INF, a warning message sometimes occurs. 
 When investigating the warning you will notice issues with activation of table ETXDCI. Please work 
 with your SAP Basis Team to resolve this issue. ONESOURCE Indirect Tax recommends that you 
 manually regenerate table ETXDCI using the Database Utility in the ABAP Workbench. 

 In transaction SE14 - Utility for Database Tables, enter table the Obj. name of ETXDCI, select 
 Tables, and click Edit. 

 2. Click the Direct (foreground) mode, click Save data, and then click the Activate and adjust
 database button to regenerate the table.
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 POPULATING DATA FIELDS WITH THE USER EXIT 
 Now that the additional fields have been defined in the SAP Standard Tax Interface, you can move 
 content into the new fields. Determining what needs to be moved and mapped is based on your 
 company’s business process, tax requirements, and system configuration. Engage your SAP 
 Functional Analyst or Consultant, your Tax Expert, and your ABAP Programmer. 

 USER EXIT USAGE: EXAMPLE 

 Assume that a material's net weight is required for accurate tax determination in a given business 
 scenario. The material weight is not part of the SAP Standard Tax Interface, so you must add it to 
 the appended fields so it will be retrieved from the SAP Material Master tables in the user exit. 

 Assume that the net weight was added as a new tax element to the SAP Standard Tax Interface. The 
 value was assigned to ZZATTRIBUTE1 in SAP by the user exit. Now that the SAP user exithas 
 moved the net weight value to ZZATTRIBUTE1, Integration for SAP will map that value to 
 <USER_ELEMENT>.<ATTRIBUTE1>. Therefore, the value is now available to ONESOURCE 
 Indirect Tax Determination in this element. 

 There are several ways you may use this element: 

 • You can simply pass the value through to audit for reporting purposes.
 • You can use a TransEditor to map the value of this element to another element. For

 example, you might use the value of this custom attribute to populate the <MASS> input
 XML element.

 • You can use a Rule Qualifier to test for the presence of a value in this custom attribute. For
 example, a qualifier may test that the net weight is over a certain amount or the rule will not
 apply.

 Please consult Determination Help for information on how to configure both TransEditors and Rule 
 Qualifiers. 
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 TESTING RFCS WITH ADDED CUSTOM ATTRIBUTES 
 This procedure assumes that you have installed the Sabrix Solution and have configured at least 
 one Sabrix Company. If not, you must first complete the instructions in the chapter DEFINING A 
 COMPANY IN DETERMINATION FOR RFC TESTING and then continue with this procedure. 

 1. Follow the same steps as noted on TESTING THE RFC DESTINATION

 Please make sure you can reach Determination using the Internet Explorer browser and the
 URL shown on the SAP screen. If you cannot reach Determination using Internet Explorer,
 then either Determination is not running or the URL provided is wrong. Consult with your
 DBA.

 2. After you execute the RFC, check the connection log to make sure that your attributes are
 mapped to the Input XML fields.
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 This chapter describes the mapping between SAP fields and Determination Input and Output XML. 

 Determination XML is organized hierarchically. A single XML data file may contain multiple 
 batches, invoices, and distribution lines. An element value set at the batch level is passed down to 
 the invoice and distribution line levels, unless overridden at a lower level. 

 The tables in this chapter describe: 

 • How SAP fields are mapped to Address Validation XML.
 • How SAP fields are mapped to Invoice level Input XML.
 • How SAP fields are mapped to Line level Input XML. Each line has a unique line ID within

 the invoice, allowing each invoice to specify line specific values (such as different Ship-To
 locations) for each line. This also includes custom attributes you created in the previous
 chapter.

 • How SAP fields are mapped to Invoice level Output XML.
 • How SAP fields are mapped to Line level Output XML.

 The following RFC modules are called for tax calculation and jurisdiction determination: 

 RFC Modules Called by Integration for SAP 

 SAP Release  Tax Calculation  Jurisdiction Determination 
 R/3 4.6 and up  RFC_CALCULATE_TAXES_DOC 

 RFC_UPDATE_TAXES_DOC 
 RFC_FORCE_TAXES_DOC 

 RFC_DETERMINE_JURISDICTION 

 Each table is displayed beneath the associated RFC. See: 

 • MAPPING FOR RFC_DETERMINE_JURISDICTION
 • MAPPING FOR RFC_CALCULATE_TAXES_DOC
 • MAPPING FOR RFC_UPDATE_TAXES_DOC
 • MAPPING FOR RFC_FORCE_TAXES_DOC
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 PREPARING FOR MAPPING 
 Before you begin the mapping process, please review: 

 • Leading Zeros
 • Freight Lines and Product Lines
 • Mapping of SAP Dates

 LEADING ZEROS 

 ONESOURCE Indirect Tax Determination maps SAP data without removing leading zeros. 
 Therefore, if you set up TransEditors, Customers, Exemptions, Products, or other master data in 
 ONESOURCE Indirect Tax, you should set them up with the leading zeros. 

 Alternatively, you can set the remove_leading_zeros parameter in the 
 SabrixConnection.properties file to TRUE, which will remove leading zeros for the following 
 elements: 

 • MAT_NR: Material Number
 • PROD_CODE: Product Code
 • GROUP_PROD_CODE: Group Product Code
 • ACCNT_NO: Customer Number or Vendor Number depending upon APAR_IND
 • ACCNT_CLS: General ledger account
 • COST_OBJECT: Cost center or other cost object (order, etc)
 • EXCERTIF: Exempt Certificate Number (Not normally used)

 FREIGHT LINES AND PRODUCT LINES 

 When freight is a condition in the pricing procedure for a line item in SAP, certain fields on the 
 product line are copied onto the freight line created by Integration. This copying process makes the 
 freight line identical to the product line with the exception of the following fields: 

 • RELATED_LINE_NUMBER: The value of this field is set to the value of the parent line
 number.

 • DESCRIPTION: The value of this field is "Freight for line xx" where xx is the line number
 from the parent line.

 • GROSS_AMOUNT: The value of this field is set based on RFC value FREIGHT_AMT.
 • LINE_NUMBER: The value of this field is the line number of parent line filled to the sixth

 position with leading zeros and a one (1) added in front, for example, 10 will be 1000010.
 • PRODUCT_CODE: The value of this field is set from the freight_prod_code in the

 SabrixConnection.properties file.

 MAPPING OF SAP DATES 

 For a detailed explanation and additional configuration options on dates please refer to Knowledge 
 Base article 839 at: 

 https://customer.sabrix.com/cgi-bin/sabrix.cfg/php/enduser/std_adp.php?p_faqid=839 

https://customer.sabrix.com/cgi-bin/sabrix.cfg/php/enduser/std_adp.php?p_faqid=839
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MAPPING FOR RFC_DETERMINE_JURISDICTION 

RFC_DETERMINE_JURISDICTION 

XML Field SAP Component Comment 

INPUT XML 
COUNTRY COUNTRY 

STATE STATE For the US only, SAP field STATE is mapped to input 
XML field STATE. 

PROVINCE STATE For all countries other than US, SAP field STATE is 
mapped to input XML field PROVINCE. 

COUNTY COUNTY 

CITY CITY 

POSTCODE ZIPCODE For US, the first 5 digits of ZIP code are mapped to 
POSTCODE; for all others countries everything from 
ZIPCODE is mapped to POSTCODE. 

GEOCODE ZIPCODE For US, the last 4 digits of ZIPCODE are mapped to this 
field; for all others countries, this field is blank. 

N/A TXJCD_L1 

N/A TXJCD_L2 

N/A TXJCD_L3 

N/A TXJCD_L4 

N/A TXJCD 

N/A OUTOF_CITY 

OUTPUT XML 
SEVERITY RETCODE A value of 0 indicates successful communication with 

Determination. 
A value of 1 indicates that an exception hasoccurred 
either in Integration itself or in its communication with 
Determination. 
A value of 2 indicates a severe errorwithin 
Determination. 

SEVERITY ERRCODE A value of 1 indicates that an exception hasoccurred 
either in Integration itself or in its communication with 
Determination. 
A value of 2 indicates a severe errorwithin 
Determination. 

MESSAGE_TEXT ERRMSG 

COUNTRY COUNTRY 

STATE STATE For the US only, SAP field STATE is mapped to input 
XML field STATE. 
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RFC_DETERMINE_JURISDICTION 

XML Field SAP Component Comment 
PROVINCE STATE For all countries other than US, SAP field STATE is 

mapped to input XML field PROVINCE. 

COUNTY COUNTY 

CITY CITY 

POSTCODE ZIPCODE 

GEOCODE ZIPCODE 

N/A TXJCD_L1 Based on jurisdiction settings in TTXD. 

N/A TXJCD_L2 Based on jurisdiction settings in TTXD. 

N/A TXJCD_L3 Based on jurisdiction settings in TTXD. 

N/A TXJCD_L4 Based on jurisdiction settings in TTXD. 

N/A TXJCD Build based on TTXD settings, see also below. 

CITY OUTOF_CITY If CITY = UNINCORPORATED set OUTOF_CITY = X. 
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 RFC_CALCULATE_TAXES_DOC INPUT XML 

 Input XML Field  SAP Component  Comment 

 SAP FIELDS INVOICE LEVEL 
 N/A  APP_SERVER 

 N/A  SAP_VERSION 

 N/A  INTERF_VERSION 

 HOST_SYSTEM  SYST_NAME 

 CALLING_SYSTEM_NUMBER  CLIENT 

 EXTERNAL_COMPANY_ID  COMP_CODE  Company for which transaction is taking 
 place. 

 INVOICE_NUMBER  DOC_NUMBER  SAP document number which is applicable to 
 tax calculation, for example sales order, 
 purchase order etc. 

 CURRENCY_CODE  CURRENCY  Currency Code from Company. 

 N/A  CURR_DEC  Used to support decimal points on values. 

 N/A  TXJCD_L1  Based on jurisdiction settings in TTXD. 

 N/A  TXJCD_L2  Based on jurisdiction settings in TTXD. 

 N/A  TXJCD_L3  Based on jurisdiction settings in TTXD. 

 N/A  TXJCD_L4  Based on jurisdiction settings in TTXD. 

 IS_AUDIT_UPDATE  TAX_PER_ITEM  This flag is blank in Order to Cash SD 
 transactions, in Procure to Pay Process, this 
 flag is X. 

 N/A  NR_LINE_ITEMS  Internally used. 

 SAP FIELDS LINE LEVEL 
 COMPANY_ROLE  APAR_IND  • If SAP TXJCD_SF = US and TXJCD_ST =

 US and APAR_IND = A and TAX Type - 0 or
 Blank, or 1, the Company Role = S (Seller)

 • If SAP TXJCD_SF = US and TXJCD_ST =
 US and APAR_IND = V and Tax Type = 0 or
 Blank, the Company Role = S (Seller)

 • If SAP TXJCD_SF = US and TXJCD_ST =
 US and APAR_IND = V and Tax Type = 1,
 then Company Role = B (Buyer)

 TRANSACTION_TYPE  N/A  GS (Goods) by default, overwritten at line 
 level. 
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 RFC_CALCULATE_TAXES_DOC INPUT XML 

 Input XML Field  SAP Component  Comment 
 INVOICE_DATE  TAX_DATE  If Tax User Exit Provides the invoice date in 

 the ZZINVDATE, then TAX_DATE will be 
 ignored. See ONESOURCE Indirect Tax 
 Integration for SAP Global Tax Configuration 
 Guide for more details. 

 LINE.REGIME  ITEM_NO  Item number in the tax document. 

 LINE_NUMBER  POS_NO  Item number in the SAP document, for 
 example, ITEM NUMBER in the Sales Order. 

 RELATED_LINE_ID  GROUP_ID  Prior to release 5.0, GROUP_ID was mapped 
 to USER_ELEMENT.ATTRIBUTE49. 

 COUNTRY_OF_ORIGIN  COUNTRY  This is the country of goods departure. 
 • In SD transactions, it is the country of the

 plant from which goods will be shipped.
 • In MM transactions it is the country of the

 company code in which AP transactions are
 created.

 USER_ELEMENT.ATTRIBUTE50  DIVISION 

 PART_NUMBER  MATNR  Material Number from line item on SAP 
 document. 

 PRODUCT_CODE  PROD_CODE  Product Code can be mapped with material 
 group in the TTXP table. There is user exit 
 code provided to query this in the tax 
 interface. 

 USER_ELEMENT.ATTRIBUTE41  GROUP_PROD_CODE 

 QUANTITY  QUANTITY 

 SUPPLEMENTARY_UNIT and 
 UNIT_OF_MEASURE 

 UNIT 

 TRANSACTION_TYPE  TAX_TYPE  • SAP TAX_TYPE 0 or 1 =
 TRANSACTION_TYPE = GS.

 • TAX_TYPE = 2 TRANSACTION_TYPE =
 DS.

 • TAX_TYPE = 3 TRANSACTION_TYPE =
 RR.

 • All other TAX_TYPES error.
 Tax Type is derived from the properties of TAX 
 Code where it is maintained on the field called 
 Tax Category Field. 

 IS_EXEMPT.ALL  EXEMP_IND  • If SAP EXEMP_IND is 'null’ or 0,
 IS_EXEMPT.ALL is not set.

 • If EXEMP_IND is 1, IS_EXEMPT.ALL is set
 to N, forcing no exemption.

 • If EXEMP_IND is 2, IS_EXEMPT.ALL is set
 to Y, forcing an exemption.
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 RFC_CALCULATE_TAXES_DOC INPUT XML 

 Input XML Field  SAP Component  Comment 
 SHIP_FROM  TXJCD_SF  • In SD transaction, this jurisdiction code

 comes from Plant from which goods will be
 shipped.

 • In MM transaction, this jurisdiction code is
 derived from Vendor location.

 SHIP_TO  TXJCD_ST  • In SD transaction, this jurisdiction code
 comes from ship-to-customer location.

 • In MM transaction, this jurisdiction code is
 derived from plant where goods will be
 received.

 • In SD/FI transactions, this is alwaysderived
 from the Customer number entered on the
 transaction.

 • In MM/FI transactions, this is a jurisdiction
 code from cost object (Cost Center, Asset,
 Plant, Tax) entered on the line item of the
 transaction.

 ORDER_ACCEPTANCE  TXJCD_POA  • In SD transaction, this jurisdiction code is
 derived from Plant. We have provideduser
 exit code to derive this code from Sales
 Organization.

 • In MM transaction, this is derived from
 Vendor location.

 • In SD/FI transactions, this is alwaysderived
 from the Customer number entered on the
 transaction.

 • In MM/FI transactions, this is a jurisdiction
 code from cost object (Cost Center, Asset,
 Plant, Tax) entered on the line item of the
 transaction.

 ORDER_ORIGIN  TXJCD_POO  • In SD Transaction, this jurisdiction code is
 derived from Ship-to Customer.

 • In MM transaction, this is derived from Plant
 where goods will be received.

 • In SD/FI transactions, this is alwaysderived
 from the Customer number entered on the
 transaction.

 • In MM/FI transactions, this is a jurisdiction
 code from cost object (Cost Center, Asset,
 Plant, Tax) entered on the line item of the
 transaction.

 GROSS_AMOUNT  AMOUNT  Net Value for Tax Calculation as determined 
 by SAP. If FREIGHT_AM is > 0, then 
 GROSS_AMOUNT = AMOUNT - 
 FREIGHT_AM. 

 USER_ELEMENT.ATTRIBUTE48  GROSS_AMOUNT  GROSS_AMOUNT is always equal to original 
 AMOUNT value. 
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RFC_CALCULATE_TAXES_DOC INPUT XML 

Input XML Field SAP Component Comment 
GROSS_AMOUNT FREIGHT_AM If FRIEGHT_AM is not equal to 0, Integration 

creates two lines for tax calculation. In that 
case a special freight line will be created in 
Integration for tax calculation purposes. 

EXEMPT_AMOUNT-STATE / 
COUNTRY 

EXEMPT_AMT For US = STATE, all others COUNTRY. 

LINE.CUSTOMER_NUMBER 
or 
LINE.VENDOR_NUMBER 

ACCNT_NO Prior to release 5.0, 
USER_ELEMENT.ATTRIBUTE47 was 
mapped to ACCNT_NO if APAR_IND = A. 
As of release 5.0 release, this mapping is 
based on APAR_IND. If APAR_IND = A, this 
represents the line ship-to Customer Number 
from SAP. 
If APAR_IND = V, this represents the Vendor 
Number from SAP. 

USER_ELEMENT.ATTRIBUTE42 ACCNT_CLS 

USER_ELEMENT.ATTRIBUTE43 COST_OBJECT 

POINT_OF_TITLE_TRANSFER PTP_IND Prior to the 5.0 release, there was user exit 
code to map PTP_IND based on INCO 
TERMS in SAP. We have still provided this 
code, but this code is optional with 5.0 release 
since Incoterms can be mapped with Point of 
Title Transfer. 
See Configuring User Exits for more 
information. 

EXEMPT_CERTIFICATE-STATE / 
COUNTRY 

EXCERTIF For US = STATE, all others COUNTRY. 

EXEMPT_REASON-STATE / 
COUNTRY 

EXREASON For US = STATE, all others COUNTRY 

USER_ELEMENT.ATTRIBUTE44 USER_DATA 

40 ADDITIONAL FIELDS 
USER_ELEMENT.ATTRIBUTE1 ZZATTRIBUTE1 CHAR 10 

USER_ELEMENT.ATTRIBUTE2 ZZATTRIBUTE2 CHAR 10 

USER_ELEMENT.ATTRIBUTE3 ZZATTRIBUTE3 CHAR 10 

USER_ELEMENT.ATTRIBUTE4 ZZATTRIBUTE4 CHAR 10 

USER_ELEMENT.ATTRIBUTE5 ZZATTRIBUTE5 CHAR 10 

USER_ELEMENT.ATTRIBUTE6 ZZATTRIBUTE6 CHAR 10 

USER_ELEMENT.ATTRIBUTE7 ZZATTRIBUTE7 CHAR 10 

USER_ELEMENT.ATTRIBUTE8 ZZATTRIBUTE8 CHAR 10 

USER_ELEMENT.ATTRIBUTE9 ZZATTRIBUTE9 CHAR 10 
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RFC_CALCULATE_TAXES_DOC INPUT XML 

Input XML Field SAP Component Comment 
USER_ELEMENT.ATTRIBUTE10 ZZATTRIBUTE10 CHAR 10 

USER_ELEMENT.ATTRIBUTE11 ZZATTRIBUTE11 CHAR 25 

USER_ELEMENT.ATTRIBUTE12 ZZATTRIBUTE12 CHAR 25 

USER_ELEMENT.ATTRIBUTE13 ZZATTRIBUTE13 CHAR 25 

USER_ELEMENT.ATTRIBUTE14 ZZATTRIBUTE14 CHAR 25 

USER_ELEMENT.ATTRIBUTE15 ZZATTRIBUTE15 CHAR 25 

USER_ELEMENT.ATTRIBUTE16 ZZATTRIBUTE16 CHAR 25 

USER_ELEMENT.ATTRIBUTE17 ZZATTRIBUTE17 CHAR 25 

USER_ELEMENT.ATTRIBUTE18 ZZATTRIBUTE18 CHAR 25 

USER_ELEMENT.ATTRIBUTE19 ZZATTRIBUTE19 CHAR 25 

USER_ELEMENT.ATTRIBUTE20 ZZATTRIBUTE20 CHAR 25 

USER_ELEMENT.ATTRIBUTE21 ZZATTRIBUTE21 CHAR 25 

USER_ELEMENT.ATTRIBUTE22 ZZATTRIBUTE22 CHAR 25 

USER_ELEMENT.ATTRIBUTE23 ZZATTRIBUTE23 CHAR 25 

USER_ELEMENT.ATTRIBUTE24 ZZATTRIBUTE24 CHAR 25 

USER_ELEMENT.ATTRIBUTE25 ZZATTRIBUTE25 CHAR 25 

USER_ELEMENT.ATTRIBUTE26 ZZATTRIBUTE26 CHAR 25 

USER_ELEMENT.ATTRIBUTE27 ZZATTRIBUTE27 CHAR 25 

USER_ELEMENT.ATTRIBUTE28 ZZATTRIBUTE28 CHAR 25 

USER_ELEMENT.ATTRIBUTE29 ZZATTRIBUTE29 CHAR 25 

USER_ELEMENT.ATTRIBUTE30 ZZATTRIBUTE30 CHAR 25 

USER_ELEMENT.ATTRIBUTE31 ZZATTRIBUTE31 CHAR 50 

USER_ELEMENT.ATTRIBUTE32 ZZATTRIBUTE32 CHAR 50 

USER_ELEMENT.ATTRIBUTE33 ZZATTRIBUTE33 CHAR 50 

USER_ELEMENT.ATTRIBUTE34 ZZATTRIBUTE34 CHAR 50 

USER_ELEMENT.ATTRIBUTE35 ZZATTRIBUTE35 CHAR 50 

USER_ELEMENT.ATTRIBUTE36 ZZATTRIBUTE36 CHAR 50 

USER_ELEMENT.ATTRIBUTE37 ZZATTRIBUTE37 CHAR 50 

USER_ELEMENT.ATTRIBUTE38 ZZATTRIBUTE38 CHAR 50 

USER_ELEMENT.ATTRIBUTE39 ZZATTRIBUTE39 CHAR 200 

USER_ELEMENT.ATTRIBUTE40 ZZATTRIBUTE40 CHAR 200 
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RFC_CALCULATE_TAXES_DOC OUTPUT XML 

Output XML Field SAP Component Comment 

SAP FIELDS INVOICE LEVEL 
Read from integration library API_VERSION Integration Version. 

Read from determination SYST_VERSION Determination Version. 

Read from library DB_VERSION SAP JCo Version. 

SEVERITY RETCODE A value of 0 indicates successful 
communication with Determination. 
A value of 1 indicates that an exception has 
occurred either in Integration itself or in its 
communication with Determination. 
A value of 2 indicates a severe error within 
Determination. 

USER_ELEMENT_ATTRBUTE49 ERROR_LINE First line found with an error. 

SEVERITY ERRCODE A value of NULL indicates that a connection 
could not be made with Determination. 
A value of 1 indicates that an exception has 
occurred either in Integration itself or in its 
communication with Determination. 
A value of 2 indicates a severe error within 
Determination. 

MESSAGE_TEXT ERRMSG Message up to 200 characters. 

SAP FIELDS LINE LEVEL 
LINE_REGIME ITEM_NO 

N/A TXJCD_IND 

N/A TAXPCOV Calculated within Integration as an effective 
rate. 

TOTAL_TAX_AMOUNT TAXAMOV 

N/A EXMATFLAG 

N/A EXCUSFLG 

TAX_EXEMPT_CERTIFICATE EXT_EXCERTIF 

TAX_EXEMPT_REASON EXT_EXREASON 

N/A NR_JUR_LEVELS 

SAP FIELDS JURIDSDICTION LEVEL 
LINE.REGIME ITEM_NO 

TAX_AUTHORITY_TYPE TXJLV 

TAX_RATE TAXPCT 

TAX_AMOUNT TAXAMT 

TAX_TAXABLE_BASIS TAXBAS 
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RFC_CALCULATE_TAXES_DOC OUTPUT XML 

Output XML Field SAP Component Comment 
TAX_EXEMPT_AMOUNT EXAMT 

TAX_EXEMPT_REASON EXCODE 
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 MAPPING FOR RFC_UPDATE_TAXES_DOC 
 Mapping for RFC_UPDATE_TAXES_DOC requires the following types of mapping in addition to 
 what is already displayed in the various sections of RFC_CALCULATE_TAXES_DOC. This is an 
 incremental list. 

 For all other field mappings, see MAPPING FOR RFC_CALCULATE_TAXES_DOC. 

 RFC_UPDATE_TAXES_DOC 

 Input XML Field  SAP Component  Comment 

 INVOICE-LEVEL INPUT XML 
 IS_AUDIT_UPDATE  TAX_PER_ITEM  For SD Transactions, this field is always blank; for 

 MM transactions, this field is always X since SAP 
 makes a call on the line level for tax calculation. If it 
 is X, then IS_AUDIT_UPDATE = Y. 

 N/A  NR_LINE_ITEMS  Internally used. 

 IS_AUDITED  N/A  If RFC CALL is UPDATE or FORCE, then 
 IS_AUDITED = Y. 

 FISCAL_DATE  REP_DATE  From first line item where REP_DATE represents 
 the posting date. 

 CALCULATION_DIRECTION  N/A  For UPDATE set to F. 

 LINE-LEVEL INPUT XML 
 N/A  REP_DATE  Mapped to Invoice Input level. 

 N/A  CREDIT_IND  If APAR_IND = V and COUNTRY does not equal 
 US or CA. 
 • If CREDIT_IND = 0, the sign is positive and

 IS_CREDIT = N.
 • If CREDIT_IND = 1, the sign is negativeand

 IS_CREDIT = Y.
 • IS_CREDIT is a line level input XML field.

 LINE-LEVEL OUTPUT XML 
 Read from Integration library  API_VERSION  Integration Version. 

 Read from Determination  SYST_VERSION  Determination Version. 

 Read from library  DB_VERSION  SAP JCo Version. 

 SEVERITY  RETCODE  A value of 0 indicates successful communication 
 with Determination. 
 A value of 1 indicates that an exception has 
 occurred either in Integration itself or in its 
 communication with Determination. 
 A value of 2 indicates a severe error within 
 Determination. 

 USER_ELEMENT.ATTRBUT 
 E49 

 ERROR_LINE  First line found with an error. 
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MAPPING FOR RFC_UPDATE_TAXES_DOC 

RFC_UPDATE_TAXES_DOC 

Input XML Field SAP Component Comment 
SEVERITY ERRCODE A value of 0 indicates successful communication 

with Determination. 
A value of 1 indicates that an exception has 
occurred either in Integration itself or in its 
communication with Determination. 
A value of 2 indicates a severe error within 
Determination. 

MESSAGE_TEXT ERRMSG Message up to 200 characters 
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 MAPPING FOR RFC_FORCE_TAXES_DOC 
 Mapping for RFC_FORCE_TAXES_DOC requires the following types of mapping in addition to 
 what is already displayed in the various sections of RFC_CALCULATE_TAXES_DOC. This is an 
 incremental list. 

 For all other field mappings, see MAPPING FOR RFC_CALCULATE_TAXES_DOC. 

 RFC_FORCE_TAXES_DOC 

 Input XML Field  SAP Component  Comment 

 INVOICE-LEVEL INPUT XML 
 IS_AUDIT_UPDATE  TAX_PER_ITEM  For SD Transactions, this field is always 

 blank; for MM transactions, this field is always 
 X since SAP makes a call on the line level for 
 tax calculation. If it is X, then 
 IS_AUDIT_UPDATE = Y. 

 N/A  NR_LINE_ITEMS  Internally used. 

 IS_AUDITED  N/A  If RFC CALL is UPDATE or FORCE, then 
 IS_AUDITED = Y. 

 FISCAL_DATE  REP_DATE  From first line item where REP_DATE 
 represents the posting date. 

 CALCULATION_DIRECTION  N/A  For FORCE set to R. 

 LINE-LEVEL INPUT XML 
 N/A  REP_DATE  Mapped to Invoice Input level. 

 N/A  CREDIT_IND  If APAR_IND = V and COUNTRY does not 
 equal US or CA. 
 • If CREDIT_IND = 0, the sign is positive and

 IS_CREDIT = N.
 • If CREDIT_IND = 1, the sign is negative and

 IS_CREDIT = Y.
 • IS_CREDIT is a line level input XML field.

 USER_ELEMENT.ATTRIBUTE45  STORE_CODE 

 USER_ELEMENT.ATTRIBUTE46  USER_REPT_DATA 

 N/A  TXJCD_IND 

 N/A  TAXPCOV 

 TAX_AMOUNT  TAXAMOV 

 N/A  EXMATFLAG 

 N/A  EXCUSFLG 

 N/A  EXT_EXCERTIF 

 N/A  EXT_EXREASON 
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RFC_FORCE_TAXES_DOC 

Input XML Field SAP Component Comment 
N/A NR_JUR_LEVELS 

LINE.REGIME ITEM_NO 

N/A TXJLV 

N/A TAXPCT 

OVERRIDE_AMOUNT.<level> TAXAMT <level> according to tax jurisdiction level. 

N/A TAXBAS 

EXEMPT_AMOUNT.<level> EXAMT <level> according to tax jurisdiction level. 

EXEMPT_REASON.<level> EXCODE <level> according to tax jurisdiction level. 

LINE-LEVEL OUTPUT XML 
Read from Integration library API_VERSION Integration Version. 

Read from Determination SYST_VERSION Determination Version. 

Read from library DB_VERSION SAP JCo Version. 

SEVERITY RETCODE A value of 0 indicates successful 
communication with Determination. 
A value of 1 indicates that an exception has 
occurred either in Integration itself or in its 
communication with Determination. 
A value of 2 indicates a severe error within 
Determination. 

USER_ELEMENT.ATTRBUTE49 ERROR_LINE First line found with an error. 

SEVERITY ERRCODE A value of 0 indicates successful 
communication with Determination. 
A value of 1 indicates that an exception has 
occurred either in Integration itself or in its 
communication with Determination. 
A value of 2 indicates a severe error within 
Determination. 

MESSAGE_TEXT ERRMSG Message up to 200 characters. 
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MAPPING FOR RFC_FORCE_TAXES_DOC 

Configure SAP to send the Invoice date instead of the posting date to Audit: 

By default SAP sends the posting date to ONESOURCE Indirect Tax audit in transactions FB60, 
FB70, MIRO, FB01 and FB05. If instead you would like to pass the Document/Invoice Date then 
you will need to follow the below steps in the FI area of configuration. 

Use SPRO transaction: Financial Accounting / Financial Accounting Global Settings / Tax on 
Sales and Purchases / Calculation / Assign Company Code to Document Type for Tax 
Determination. 
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 ONESOURCE INDIRECT TAX TRANSPORTS 

 Transports for the basic installation guide are located on your computer as noted in this screenshot 
 example below. You will find them in the Code folder which is in SBXIntegrationSAP5.2.2.0B 
 folder. 

 Have your basis person locate and install this transport as shown in the table below. 

 Transport 
 Number Files  Page Reference  Purpose 
 K900186.DO2 
 R900186.DO2 

 ONESOURCE Indirect Tax 
 Integration for SAP - 40 
 Input User Attributes 

 SAP package for the 
 transport, and 
 append/addition of 40 
 attribute fields 

 For upgrade customers transports should be imported with the "Overwrite Originals" 
 check box selected when importing the transport. In cases where a customer already 
 has prior existing objects imported or setup in their system and they import a newer 
 transport which alters these objects an error is raised during the import if the “Overwrite 
 Original” box is not checked. 

 As your basis person adds this transport you can refer to the information below in order to confirm 
 that the transports added all items as expected. 

 K900186.DO2/R900186.DO2 

 ONESOURCE Indirect Tax Integration for SAP - 40 Input User Attributes 

 After applying this transport, you will have the following items added to your system: 

 • Package Z_Sabrix_Connector
 • Newly created structure ZUSERELEMENTS_ITEM that includes 40 new customer

 attributes.
 • Appended SAP Tax Tables. The following table lists the SAP tables that are now appended

 and within the appends, inclusion of the new ZUSERELEMENTS_Item Structure.
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. 

SAP Tables to Append 

Component Append Append Name 
TAX_CAL_ITEM_IN00 ZATAX_CAL_ITEM_IN00 Sabrix Append 

TAX_UPD_ITEM_IN00 ZATAX_UPD_ITEM_IN00 Sabrix Append 

TAX_FRC_ITEM_IN00 ZATAX_FRC_ITEM_IN00 Sabrix Append 

TAX_USER_INF ZATAX_USER_INF Sabrix Append 

TAX_ALLOWED_FIELDS ZATAX_ALLOWED_FIELDS Sabrix Append 
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APPENDIX 3: ADVANCED SECURITY 
AND LOGGING CONFIGURATIONS 

PASSWORD ENCRYPTION AND USER AUTHENTICATION 
ONESOURCE Indirect Tax provides integrated user authentication between Determination and 
Integration for SAP. When it starts, Integration authenticates with SAP and can optionally 
authenticate with Determination for each transaction. The username and password information for 
this authentication is contained in the SabrixConnection.properties file. 

The following is a list of the usernames and passwords in the SabrixConnection.properties file: 

• SABRIX_user
• SABRIX_password
• jco.client.user
• jco.client.passwd

Although you must supply the jco.client.user and jco.client.passwd values, you would only use 
SABRIX_user and SABRIX_password if you wanted to authenticate each transaction. To enable 
this, set the system configuration parameter CALC_AUTHENTICATION_REQUIRED. When this 
parameter is set to Y in Determination, it authenticates the user and password for every 
transaction. 

To protect your username and password information, you can encrypt it in the 
SabrixConnection.properties file. Follow instructions below to encrypt these values, and after 
inserting these encrypted values into the .properties file, set the following: 

encrypt_passwords=true 

Once you have set this property to true, Integration for SAP assumes that you have encrypted all 
username and password information. If you mistakenly set this to true but do not actually encrypt 
the username and password values, then Integration will not authenticate with SAP. 

Passwords are not shown in the SABRIXIntegrationServer.log; they are replaced with a 
value of "REMOVED FOR SECURITY". 

To encrypt username and password information, follow the instructions for your operating system: 

Microsoft Windows Systems 

Use IntegrationServerEncryptText.bat file provided with Integration for SAP distribution. Run 
IntegrationServerEncryptText.bat from a command prompt, providing the text value that needs to 
be encrypted. For example, to encrypt the word test execute the following: 

<Install Directory>IntegrationServerEncryptText test

**dAVzdG 

The generated password is **dAVzdG. It can be copied into the SabrixConnection.properties file in 
place of the plain text. 
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UNIX Systems 

Use IntegrationServerEncryptText.sh file provided with Integration for SAP distribution. Run 
IntegrationServerEncryptText.sh from a command prompt, providing the text value that needs to 
be encrypted. For example, to encrypt the word “test” execute the following: 

./IntegrationServerEncryptText.sh test

**dAVzdG

The generated password is **dAVzdG. It can be copied into the SabrixConnection.properties file in 
place of the plain text. 
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APPENDER FILE CONFIGURATION FOR THE 6 APPENDER FORMATS 

THE SIMPLEFILEAPPENDER 

Uncomment the SimpleFileAppender <File> </File> XML tag and comment the 
ZipRollingFileAppender XML tag <RollingRandomAccessFile> </RollingRandomAccessFile> and other 
appenders <RollingFile> </RollingFile> XML tags if not already commented. 
For a given integration, only one appender can be active at a time. 

To comment XML tags use syntax <!-- comment XML tag --> 

<File name="SimpleFileAppender" fileName="./log/SabrixIntegrationServer.log"> 
 <PatternLayout> 

 <Pattern>%d [%-5level] [%t] %c - %m%n</Pattern> 
    </PatternLayout> 

  </File> 

You can modify the following ATTRIBUTES to meet your needs: 

SIMPLEFILEAPPENDER ATTRIBUTES 

Attribute Purpose 
fileName Specifies the log directory and the log file 

name. 
The default value is: 
./log/SabrixIntegrationServer.log

To use this appender, set the value of  AppenderRef in the Logger component and Root 
component  to SimpleFileAppender. For example: 

<Logger name="com.sabrix.integration" level="ERROR" additivity="false"> 
<AppenderRef ref="SimpleFileAppender"/> 

</Logger> 

<Root level="ERROR"> 
<AppenderRef ref="SimpleFileAppender"/> 

</Root> 
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THE DAILYROLLINGFILEAPPENDER 

Uncomment the DailyRollingFileAppender <RollingFile> </RollingFile> XML tag and comment the 
ZipRollingFileAppender XML tag <RollingRandomAccessFile> </RollingRandomAccessFile> and other 
appenders <RollingFile> </RollingFile>, <File> </File> XML tags if not already commented. 
For a given integration, only one appender can be active at a time. 

<RollingFile name="DailyRollingFileAppender" 
fileName="./log/SabrixIntegrationServer.log" 
filePattern="./log/SabrixIntegrationServer-%d{yyyy-MM-dd}.log"> 
<PatternLayout> 

<pattern>%d [%-5level] [%t] %c - %m%n</pattern> 
</PatternLayout> 
<Policies> 

<TimeBasedTriggeringPolicy interval="1" modulate="true" /> 
</Policies>  
<DefaultRolloverStrategy max="10"/></RollingFile> 

You can modify the following ATTRIBUTES to meet your needs: 

DAILYROLLINGFILEAPPENDER ATTRIBUTES 

Attribute Purpose 
filename Specifies the log directory and the log file 

name. 
The default value is: 
./log/SabrixIntegrationServer.log

filePattern Specifies the date pattern to use in the time 
stamp. 
The default value is yyyy-MM-dd 

Max Specifies the number of backup files to keep. 
The default value is 10.

To use this appender, set the value of AppenderRef in the Logger component and Root 
component to DailyRollingFileAppender. For example: 

<Logger name="com.sabrix.integration" level="ERROR" additivity="false">
 <AppenderRef ref="DailyRollingFileAppender"/> 
</Logger> 

<Root level="ERROR"> 
 <AppenderRef ref="DailyRollingFileAppender"/> 
</Root> 
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THE COMPOSITEROLLINGFILEAPPENDER 

Uncomment the CompositeRollingFileAppender <RollingFile> </RollingFile> XML tag and comment the 
ZipRollingFileAppender XML tag <RollingRandomAccessFile> </RollingRandomAccessFile> and other 
appenders <RollingFile> </RollingFile>, <File> </File> XML tags if not already commented. 
For a given integration, only one appender can be active at a time. 

<RollingFile name="CompositeRollingFileAppender" 
fileName="./log/SabrixIntegrationServer.log" 
filePattern="./log/SabrixIntegrationServer-%d{yyyy-MM-dd}.%i.log"> 
<PatternLayout> 

<pattern>%d [%-5level] [%t] %c - %m%n</pattern> 
</PatternLayout> 
<Policies> 

<TimeBasedTriggeringPolicy interval="1" modulate="true" /> 
<SizeBasedTriggeringPolicy size="10MB" /> 

</Policies> 
<DefaultRolloverStrategy max="10"/> 

</RollingFile> 

You can modify the following ATTRIBUTES to meet your needs: 

Control log file maximum size with the size attribute. Default value is 10MB; the value can be changed. 
Control the number of backup files to keep with max attribute. Keep ten backup files; the value can be changed. 

COMPOSITEROLLINGFILEAPPENDER ATTRIBUTES 

Attribute Purpose 
fileName Specifies the log directory and the log file name. 

The default value is: 
./log/SabrixIntegrationServer.log

filePattern Specifies Rollover log file name along with the date 
pattern to use in the time stamp and numeric value 
(%i) 
The default date pattern value is yyyy-MM-dd

Size Specifies the maximum file size; once this limit is 
met, log rolling occurs. 
The default value is 10MB.

Max Specifies the number of backup files to keep. 
The default value is 10.

To use this appender, set the value of AppenderRef in the Logger component and Root component to 
CompositeRollingFileAppender. For example:

<Logger name="com.sabrix.integration" level="ERROR" additivity="false"> 
 <AppenderRef ref="CompositeRollingFileAppender"/> 
</Logger> 

<Root level="ERROR"> 
 <AppenderRef ref="CompositeRollingFileAppender"/> 
</Root> 
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<Console name="ConsoleAppender" target="SYSTEM_OUT"> 

   <PatternLayout pattern="%d [%-5level] [%t] %c - %msg%n"/
> </Console> 

THE ROLLINGFILEAPPENDER 

Uncomment the RollingFileAppender <RollingFile> </RollingFile> XML tag and comment the 
ZipRollingFileAppender XML tag <RollingRandomAccessFile> </RollingRandomAccessFile> and other 
appenders <RollingFile> </RollingFile>, <File> </File> XML tags if not already commented. 
For a given integration, only one appender can be active at a time. 

<RollingFile name="RollingFileAppender" fileName="./log/SabrixIntegrationServer.log" 
filePattern="./log/SabrixIntegrationServer.%i.log"> 

<PatternLayout> 
<pattern>%d [%-5level] [%t] %c - %m%n</

pattern> </PatternLayout> 
<Policies> 

<SizeBasedTriggeringPolicy size="10MB" /> 
</Policies> 

<DefaultRolloverStrategy max="10"/> 
</RollingFile> 

You can modify the following ATTRIBUTES to meet your needs: 

Control the log file maximum size with the size attribute. Default value is 10MB; the value can be 
changed. 
Control the number of backup files to keep with max attribute. Keep ten backup files; the value can be 
changed. 

ROLLINGFILEAPPENDER ATTRIBUTES 

Attribute Purpose 
fileName Specifies the log directory and the log file name. 

The default value is: 
./log/SabrixIntegrationServer.log

filePattern Specifies rollover log file name along with the 
incremented numeric value (%i) 

size Specifies the maximum file size; once this limit is 
met, log rolling occurs. 
The default value is 10MB.

max Specifies the number of backup files to keep. 
The default value is 10.

THE CONSOLEAPPENDER
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To use this appender, set the value of AppenderRef in the Logger component and Root component to 
RollingFileAppender. For example: 

<Logger name="com.sabrix.integration" level="ERROR" additivity="false"> 
 <AppenderRef ref="RollingFileAppender"/> 
</Logger> 

<Root level="ERROR"> 
 <AppenderRef ref="RollingFileAppender"/> 
</Root> 

THE ZIPPINGFILEAPPENDER 

<RollingRandomAccessFile name="ZipRollingFileAppender" 
fileName="./log/SabrixIntegrationServer.log" 
filePattern="./log/SabrixIntegrationServer-%d{yyyy-MM-dd_HH}.log.zip"> 

<PatternLayout> 
<pattern>%d [%-5level] [%t] %c - %m%n</pattern> 

</PatternLayout> 
<Policies> 

<TimeBasedTriggeringPolicy interval="1" modulate="true" /> 
 </Policies>  
</RollingRandomAccessFile> 

You must use .gz or .zip at the end of the file location. 

CONFIGURATION EXAMPLES 

Configuration XML tag with status of DEBUG: 

<Configuration status="DEBUG"> 

Configure Status attribute to log the level of internal Log4j events that should be logged to the console 
(SabrixOut.txt or startSabrixConnection.log file). Valid values for this attribute are "off", "debug", "info", 
"warn", "error", "fatal". Log4j will log details about initialization, rollover and other internal actions to the 
status logger. Setting status="debug" is one of the first tools available to you if you need to troubleshoot 
log4j. Recommend to provide status=”error” in production environment to avoid huge logs over a 
period. 

SimpleFileAppender with log level of ERROR: 

<Logger name="com.sabrix.integration" level="ERROR" additivity="false"> 
<AppenderRef ref="SimpleFileAppender"/> 

</Logger> 

DailyRollingFileAppender with a maximum backup index of 5 
and a log level of INFO: 

<Logger name="com.sabrix.integration" level="INFO" additivity="false"> 
<AppenderRef ref="DailyRollingFileAppender"/> 

</Logger> 

... 
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<RollingFile name="DailyRollingFileAppender" 
fileName="./log/SabrixIntegrationServer.log" 
filePattern="./log/SabrixIntegrationServer-%d{yyyy-MM-dd}.log"> 
<PatternLayout> 

<pattern>%d [%-5level] [%t] %c - %m%n</pattern> 
</PatternLayout> 
<Policies> 

<TimeBasedTriggeringPolicy interval="1" modulate="true" /> 
</Policies> 
<DefaultRolloverStrategy max="5"/> 

</RollingFile> 

CompositeRollingFileAppender with a maximum file size 100 MB, maximum 
backup index of 10 and at log level of ERROR: 

<Logger name="com.sabrix.integration" level="ERROR" additivity="false"> 
<AppenderRef ref="CompositeRollingFileAppender"/> 

</Logger> 

<RollingFile name="CompositeRollingFileAppender" 
fileName="./log/SabrixIntegrationServer.log" 
filePattern="./log/SabrixIntegrationServer-%d{yyyy-MM-dd}.%i.log"> 
<PatternLayout> 

<pattern>%d [%-5level] [%t] %c - %m%n</pattern> 
</PatternLayout> 
<Policies> 

<TimeBasedTriggeringPolicy interval="1" modulate="true" /> 
<SizeBasedTriggeringPolicy size="100MB" /> 

</Policies> 
<DefaultRolloverStrategy max="10"/> 

</RollingFile> 

To comment ZipRollingFileAppender enclose the <RollingRandomAccessFile> 
</RollingRandomAccessFile> XML tags within start comment symbol <!-- and 
end comment symbol --> : 

<!-- 
<RollingRandomAccessFile name="ZipRollingFileAppender"

fileName="./log/SabrixIntegrationServer.log" 
filePattern="./log/SabrixIntegrationServer-%d{yyyy-MM-dd_HH}.log.zip"> 

<PatternLayout> 
<pattern>%d [%-5level] [%t] %c - %m%n</pattern> 

</PatternLayout> 
<Policies> 

<TimeBasedTriggeringPolicy interval="1" modulate="true" /> 
 </Policies>  
</RollingRandomAccessFile> 

--> 

To uncomment CompositeRollingFileAppender remove the <RollingFile> 
</RollingFile> XML tags within start comment symbol <!-- and end comment 
symbol --> : 

<RollingFile name="CompositeRollingFileAppender" 
fileName="./log/SabrixIntegrationServer.log" 
filePattern="./log/SabrixIntegrationServer-%d{yyyy-MM-dd}.%i.log"> 
<PatternLayout> 

<pattern>%d [%-5level] [%t] %c - %m%n</pattern> 
</PatternLayout> 
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<Policies> 
<TimeBasedTriggeringPolicy interval="1" modulate="true" /> 
<SizeBasedTriggeringPolicy size="100MB" /> 

</Policies> 
<DefaultRolloverStrategy max="10"/> 

</RollingFile> 
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